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C H A P T E R 1

Getting Started

Welcome to BEA Guardian: An Overview

Overview

What is Guardian ?
Guardian is a diagnostic tool that finds potential problems in your environment before they occur.

How does it work ?
Guardian is like having all of BEA's customer support engineers scrutinize your domain and 
present their findings and recommendations to you.

How do you run it ?
Select a domain, select a signature bundle, and launch an evaluation. Then review our 
recommendations and decide how to proceed. You can also download new signatures from BEA.

Where can I run it ?
Guardian can run on Windows or Linux systems that have Version 5 of Java installed.

Guardian can evaluate any platform based on WebLogic Server Versions 8.1 and 9.x, regardless 
of operating system. As long as Guardian can install and interact with the Guardian Agents, 
Guardian can evaluate it.
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Key Concepts
Evaluation is the primary function of Guardian. Evaluations detect the signatures of 
potential problems in your domain and recommend solutions to fix them. 

The signature is the crucial component of Guardian. It contains the distilled knowledge of 
BEA Support to both detect potential problems in your domain and recommend solutions. 
The latest signatures can be downloaded from BEA. 

A domain is a logically related group of WebLogic Server resources that you manage as a 
unit. The central point of contact is the Administration Server. A Domain Inventory is an 
XML document that describes a domain's servers, JVMs, operating systems, and databases. 
Guardian uses the Domain Inventory to determine which signatures are applicable to your 
domain. 

The Guardian Agent is Guardian's data collector. It is a lightweight web application that 
Guardian installs on your domain to gather data needed for evaluations. The Guardian 
Agent for WebLogic can collect JMX data, Java system properties and database metadata 
for your JDBC connection pools. 

To safeguard your domains, Guardian requires valid login credentials for all 
communications. Any passwords, usernames, or server names persisted on disk are 
encrypted. SSL encryption is available for communication between Guardian and your 
domains and between Guardian and BEA. Please note that Guardian uses 128 bit open 
source encryption for SSL.

Key Tasks
Activate 

Activate a domain to prepare it for evaluation. For a WebLogic domain, you provide the 
URL of the Administration Server and an administrator account username and password. 
Guardian installs and deploys the Guardian Agent web application and collects some 
domain data to create a Domain Inventory.

Evaluate 

Select a domain to target, select a bundle of signatures to evaluate, and launch an 
evaluation. Guardian collects the data that indicates the presence of the signatures and 
creates an Evaluation Summary.

Analyze 
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Review the Evaluation Summary to determine your response to any signatures that are 
detected. If you need more help resolving the potential problem the signature identified, 
you can have Guardian create a BEA support case.

Update 

Connect to the Guardian update site to download and install new signatures and Guardian 
application enhancements. BEA support engineers are creating new signatures based on 
knowledge gained from support cases every day.

Related Concepts
Evaluation 

Signature 

Domain 

Domain Inventory 

Guardian Agent 

Security & Privacy 

Support Case 

Related Tasks
Activate Domain 

Evaluate Domain 

Update Guardian

Related Reference
Evaluation Summary 

Related Getting Started
Supported Configurations 

Supported Targets 
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Usage Scenarios
The Usage Scenarios describe some of the different ways you can use BEA Guardian to find 
problems before they impact your environment.

Scenario 1: Development Cycle Evaluations
As you develop an application and migrate from development to quality assurance to production, 
run an evaluation at each stage. Guardian will help ensure that each phase of your development 
process is compliant with BEA's best practices.

Scenario 2: Heavy Load Evaluations
Some signatures are designed to evalute runtime domain settings. Running an evaluation under 
heavy load can detect the signatures of potential problems that would not otherwise be detected. 
BEA recommends conducting these evaluations during load and performance testing.

Scenario 3: Application Update Evaluations
After you update an existing application, run an evaluation to assess the deployment. Guardian 
will help you find the signatures of any potential problems that could impact your upgrade.

Scenario 4: Vendor Software Update Evaluations
After you install a new BEA patch, service pack, or upgrade, or install or upgrade new third party 
software, run an evaluation to identify any signatures that may have been introduced.

Scenario 5: Post Repair Evaluations
If Guardian earlier detected a signature and you made a change to resolve the problem, run an 
evaluation to confirm that the signature is no longer detected and no new signatures were 
introduced.

Scenario 6: Post Domain Change Evaluations
If you made changes to your domain configuration or settings, run an evaluation to confirm that 
the result is compliant with BEA's best practices.
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Scenario 7: Scheduled Overnight Evaluations
If you're concerned about domain settings being incorrectly changed overnight, or your domain 
approaching certain resource limits, schedule evaluations to run overnight. You can review the 
Evaluation Summary in the morning and decide if any detected signatures merit further 
investigation.

Scenario 8: Heartbeat Evaluations
Guardian evaluations are designed to have as minimal impact on throughput and CPU usage as 
possible. If your domain has extra capacity, you can schedule Guardian to run evaluations at 
regular intervals, for example, every 15 minutes. Then, if any changes are made or certain 
thresholds are reached, you can be quickly notified.

Scenario 9: Diagnostic Evaluations
When you notice a problem on your domain, run an evaluation. Even if an earlier evaluation 
detected no signatures, something may have changed since then to cause the problem observed. 
Guardian can be your first line of defense in diagnosing and repairing domain problems you 
observe.

Related Concepts
Evaluation 

Domain 

Signature 

Related Tasks
Evaluate Domain 

Related Reference
Evaluation Summary 

Related Getting Started
Running Scripts 



Get t ing  Star ted

1-6 BEA Guardian User Guide

Supported Configurations
The Supported Configurations are the environments in which the BEA Guardian application can 
be installed and run. This is distinct from the Supported Targets which are the environments that 
Guardian can target for a evaluations.

Please note that Guardian requires Java Version 5 to run.

Guardian is supported in the following environments:

Related Concepts
Evaluation 

Related Getting Started
Supported Targets 

Release Notes/Known Issues 

Operating System Vendor/Version

Windows XP, 2003, 2000

Linux Red Hat Enterprise Linux 3, 4
Requires installation of Mozilla

Java Runtime Environment Version Vendor

V5 (also known as V1.5) JRockit, Sun



Welcome to  BEA  Guard ian :  An  Overv i ew

BEA Guardian User Guide 1-7

Supported Targets
The Supported Targets are the environments that BEA Guardian can target for evaluations. This 
is distinct from the Supported Configurations, which are the environments in which the Guardian 
application itself can be installed and run.

Basically, Guardian can target any platform for evaluation that allows it to install and 
communicate with the Guardian Agent web application. In addition, the Guardian Agent itself 
must have access to a specific set of Java system information properties and methods. The BEA 
products capable of supporting these operations are based on WebLogic Server versions 8.1 and 
9.x, and include the following:

BEA Product Versions

AquaLogic Data Services Platform 2.0 and all available Service Packs

AquaLogic Data Services Platform 2.1

AquaLogic Service Bus 2.0

AquaLogic Service Bus 2.1

AquaLogic Service Bus 2.5

WebLogic Communications Platform SIP 
Server

2.2

WebLogic Integration 8.1 and all available Service Packs

WebLogic Integration 8.5 and all available Service Packs

WebLogic Platform 8.1 and all available Service Packs

WebLogic Portal 8.1 and all available Service Packs

WebLogic Portal 9.2

WebLogic RFID Enterprise Server 1.1

WebLogic RFID Enterprise Server 2.0

WebLogic Server 8.1 and all available Service Packs

WebLogic Server 9.0
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Related Concepts
Evaluation 

Guardian Agent 

Related Getting Started
Supported Configurations 

WebLogic Server 9.1

WebLogic Server 9.2
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Installation
Please note that Guardian requires Java Version 5 to run.

The Guardian installation is performed by running the guardian_installer.exe 
executable. To run the Guardian installer on Linux in Console Mode (with no Graphical User 
Interface), run the command, ./ guardian_installer.bin -i console. Otherwise, 
when you run the Guardian installer, the InstallAnywhere preparation window appears.

Figure 1-1  Installation Preparing to Install

The Guardian installer then takes you through the following steps:

Language Selection - select your native language from the drop down list and click the OK 
button. 
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Figure 1-2  Installation Language Selection

Introduction - read the introduction and click the Next button. 
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Figure 1-3  Installation Introduction

License Agreement - read the license terms, select the "I accept" radio button, and click the 
Next button. 



Get t ing  Star ted

1-12 BEA Guardian User Guide

Figure 1-4  Installation License Agreement

Choose Install Folder - select a folder in which to install Guardian and click the Next 
button. Clicking the Choose button allows you to navigate to the installation folder you 
want or create a new folder. 



Welcome to  BEA  Guard ian :  An  Overv i ew

BEA Guardian User Guide 1-13

Figure 1-5  Installation Choose Install Folder

Pre-Installation Summary - review the Pre-Installation Summary and click the Install 
button to start the installation. Click the Previous button if you need to change anything. 
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Figure 1-6  Installation Pre-Installation Summary

Installing BEA Guardian - wait for the installation to complete. 
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Figure 1-7  Installation Progress Indicator

Install Complete - click the Done button. Congratulations! You have successfully installed 
Guardian. 
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Figure 1-8  Installation Complete

Once the installation is complete, you can start Guardian from the Windows Start menu, or by 
invoking the guardian.exe executable in your installation directory. 

Related Getting Started
Starting the Graphical User Interface 
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Launching the Application
Launching the Application refers to the two different ways to run BEA Guardian: using the 
Graphical User Interface and using the Command Line Interface. The Graphical User Interface 
provides more functionality and is easier to use. But the Command Line Interface provides 
scripting capabilities that the Graphical User Interface does not have.

Related Getting Started
Starting the Graphical User Interface 

Starting and Using the Command Line Interface 
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Starting the Graphical User Interface
You can start the BEA Guardian Graphical User Interface (GUI) from either the Windows Start 
menu, or by invoking the guardian.exe executable in your Guardian installation directory.

When Guardian starts, it opens the Select Workspace dialog box. Select Workspace prompts you 
for the Guardian Workspace directory that holds the Domain Inventories, Evaluation Summaries, 
and Case Archives for each domain. Although you select the Guardian Workspace location, it 
must be separate from the Guardian installation directory. This requirement preserves the implicit 
contract with the customer that their data will never be removed, even during uninstallation.

Figure 1-9  Guardian Select Workspace Dialog Box

The default Guardian Workspace location is in your home directory; for example, 
C:\Documents and Settings\<username>\guardianWorkspace for Windows, 
and /home/<username>/guardianWorkspace for Linux. The default workspace 
location is especially important for the Guardian Command Line Interface in the case where you 
run it before the Graphical User Interface and have not yet had a chance to select a Guardian 
Workspace location.

To change the Guardian Workspace location, click the Browse button and navigate to the location 
you want. You can also create a new Guardian Workspace directory by clicking the Make New 
Folder button.
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Figure 1-10  Guardian Browse for Folder Dialog Box

If you select the Use this as the default workspace and do not ask again check box in the Select 
Workspace dialog box, Guardian will use the current Guardian Workspace location from then on, 
and will not open the Select Workspace dialog box when starting. To resume opening the Select 
Workspace dialog box at startup, select the Prompt for workspace on startup check box in the 
Startup and Shutdown section of the Preferences page.
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Figure 1-11  Preferences Prompt for Workspace on Startup

After you click the Finish button in the Select Workspace dialog box, the Guardian main window 
opens with the Welcome page. The Welcome page gives an overview of Guardian's features and 
key concepts. To exit the Welcome page, click the close icon in the upper left corner, or the Go 
to the Guardian application icon in the upper right corner.
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Figure 1-12  Guardian Welcome Screen

When you close the Welcome page, the Guardian main window opens with the Domain Explorer 
in the Navigation Pane. Guardian is now ready for you to activate and evaluate your domains and 
review the results.
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Figure 1-13  Guardian Default Perspective

Related Concepts
Guardian Workspace 

Domain Inventory 

Domain 

Related Tasks
Submit Support Case 

Related Reference
Evaluation Summary 

Preferences 

Domain Explorer 

Navigation Pane 
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Related Getting Started
Installation 

Starting and Using the Command Line Interface

Interacting with the Graphical User Interface 
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Starting and Using the Command Line Interface
The BEA Guardian Command Line Interface is accessed with a Windows Command Prompt 
window or a Linux terminal window. The Guardian command interpreter is an executable .cmd 
batch file for Windows, and a .sh shell script for Linux. Both the Windows batch file and the 
Linux shell script are wrappers that accumulate and organize arguments to the Java command.

To use the Guardian Command Line Interface, run the guardianHeadless.cmd (for Windows) or 
guardianHeadless.sh (for Linux) executable file which was placed in the installation directory 
you specified when you installed Guardian.

If you have not previously set your Guardian Workspace location when starting the Graphical 
User Interface, the Guardian Command Line Interface will use a default Guardian Workspace 
location, unless you specify otherwise in each command. The default Guardian Workspace 
location is in your home directory; for example, C:\Documents and 
Settings\<username>\guardianWorkspace for Windows, and 
/home/<username>/guardianWorkspace for Linux. If you have previously set your 
Guardian Workspace location, the Guardian Command Line Interface will use that location for 
all its operations, unless you specify otherwise in each command. Identifying the Guardian 
Workspace location is essential for accessing the correct set of active domains, Domain 
Inventories, and Evaluation Summaries.

The Guardian Command Line Interface accepts a variety of commands that perform almost every 
task available with the Graphical User Interface. To see a list of the commands available and their 
syntax, type guardianHeadless -ghelp at your operating system's command prompt. 
Please note that the Guardian Command Line Interface commands are case sensitive.

The output of each command is not sent to the console window. Instead, it is sent to the output 
file, headless_output.txt. The output file created in your current directory, and is 
overwritten each time you run it.

Also note that each command must be preceded with "-g", as shown in the following examples. 
Please pay special attention to the spacing, the arguments that require quotes, and the case 
sensitivity.

guardianHeadless.cmd -glistActiveDomains 

guardianHeadless.cmd -gactivateDomain -t 
http://localhost:9116 -u un -p pw -c true -data 
"D:\MyData\Guardian Data Directories\Installer-2079" 
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guardianHeadless.cmd -gcreateShortcut -d Naxos_localhost_9116 
-b 2 

guardianHeadless.cmd -gdeleteShortcut -s "Security Advisories 
in Naxos" 

The following table describes each Guardian command. After that is a syntax description for each 
command.

The following list gives the syntax for each command that accepts arguments. Optional 
parameters are enclosed in square brackets:

Command What It Does 

activateDomain Activates the domain specified to prepare it for evaluation and 
returns the domain identifier. 

createShortcut Creates a shortcut for the domain and bundle specified to save 
keystrokes in conducting evaluations. 

deactivateDomain Removes the domain specified from evaluation eligibility. 

deleteShortcut Deletes the shortcut specified. 

evaluateDomainBundle Evaluates the domain and bundle specified. Use the Graphical User 
Interface to see the evaluation results. 

evaluateShortcut Evaluates the domain and bundle associated with the shortcut 
specified. Use the Graphical User Interface to see the evaluation 
results.

help Displays usage information. 

listActiveDomains Lists the active domains available for evaluation in domain 
identifier format.

listBundles Lists the bundle identifier and bundle name of the bundles available 
for evaluation.

listShortcuts Lists the shortcuts available for evaluation.

script Executes the commands contained in the script file specified.
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activateDomain -t targetUrl -u username -p password [ -c persistCredentials ] [ -data 
workspaceDir ] 

– targetUrl: the http://listen-address:port-number format address of the 
domain's administration server (not in quotes) 

– username: administrator account username for the specified domain 

– password: administrator account password for the specified domain 

– persistCredentials (true or false, without quotes): whether to persist the username and 
password in encrypted form (default = false) 

– workspaceDir: the full directory specification, in quotes, of the location of the Guardian 
Workspace 

createShortcut -d domainId [ -b bundleId ] [ -s shortcutName ] [ -data workspaceDir ] 

– domainId: the domain identifier for the shortcut 

– bundleId: the bundle identifier for the shortcut (default = 0, which is the identifier for 
the bundle named, "Default Signatures"). The values for all the bundles can be found 
with the listBundles command. 

– shortcutName: the name of the shortcut in quotes (default = "<bundle name> in 
<domain name>") 

– workspaceDir: the full directory specification, in quotes, of the location of the Guardian 
Workspace 

deactivateDomain -d domainId [ -l deleteUserData ] [ -data workspaceDir ] 

– domainId: the domain identifier of the domain to deactivate 

– deleteUserData (true or false, without quotes): whether to delete the Domain 
Inventories and Evaluation Summaries from the Guardian Workspace (default = false) 

– workspaceDir: the full directory specification, in quotes, of the location of the Guardian 
Workspace 

deleteShortcut -s shortcutName [ -data workspaceDir ] 

– shortcutName: the name of the shortcut to delete, in quotes, as shown with the 
listShortcuts command. 

– workspaceDir: the full directory specification, in quotes, of the location of the Guardian 
Workspace 
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evaluateDomainBundle -d domainId [ -b bundleId ] [ -u username -p password ] [ -c 
persistCredentials ] [ -data workspaceDir ] 

– domainId: the domain identifier of the domain to evaluate 

– bundleId: the bundle identifier for the shortcut (default = 0, which is the identifier for 
the bundle named, "Default Signatures"). The values for all the bundles can be found 
with the listBundles command. 

– username: administrator account username for the specified domain (not required if 
persistCredentials set to true in activateDomain) 

– password: administrator account password for the specified domain (not required if 
persistCredentials set to true in activateDomain) 

– persistCredentials (true or false, without quotes): whether to persist the username and 
password in encrypted form (default = false) 

– workspaceDir: the full directory specification, in quotes, of the location of the Guardian 
Workspace 

evaluateShortcut -s shortcutName [ -u username -p password ] [ -c persistCredentials ] [ 
-data workspaceDir ] 

– shortcutName: the name of the shortcut to evaluate in quotes 

– username: administrator account username for the specified domain (not required if 
persistCredentials set to true in activateDomain) 

– password: administrator account password for the specified domain (not required if 
persistCredentials set to true in activateDomain) 

– persistCredentials (true or false, without quotes): whether to persist the username and 
password in encrypted form (default = false) 

– workspaceDir: the full directory specification, in quotes, of the location of the Guardian 
Workspace 

help 

listActiveDomains [ -data workspaceDir ] 

– workspaceDir: the full directory specification, in quotes, of the location of the Guardian 
Workspace 

listBundles [ -data workspaceDir ] 

– workspaceDir: the full directory specification, in quotes, of the location of the Guardian 
Workspace 
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listShortcuts [ -data workspaceDir ] 

– workspaceDir: the full directory specification, in quotes, of the location of the Guardian 
Workspace 

script -f scriptname [ -data workspaceDir ] 

– scriptname: the name of a script file containing Guardian commands. Each command 
has to be on a separate line. See Running Scripts for more information. 

– workspaceDir: the full directory specification, in quotes, of the location of the Guardian 
Workspace 

Related Concepts
Guardian Workspace

Domain 

Shortcut 

Evaluation 

Bundle 

Domain Inventory 

Related Tasks
Activate Domain 

Create Shortcut 

Deactivate Domain 

Delete Shortcut 

Evaluate Domain

Related Reference
Domain Explorer 

Evaluation Summary 
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Related Getting Started
Installation 

Starting the Graphical User Interface

Running Scripts 
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Running Scripts
Running Scripts allows you to perform several Guardian tasks with one command, using the 
Guardian Command Line Interface. You can schedule scripts to run at specified times and 
intervals by using utilities such as the Windows Task Scheduler or the Linux crontab command.

Here is an example of a script (activate.txt) that activates several domains:

activateDomain -t http://slp7:7001 -u un -p pw -c true
activateDomain -t http://slp8:7001 -u un -p pw -c true
activateDomain -t http://sqa-lldev:4044 -u un -p pw -c true
activateDomain -t http://slg-lldev:7001 -u un -p pw -c true
activateDomain -t http://slg-lldev:4401 -u un -p pw -c true
activateDomain -t http://mj23:32292 -u un -p pw -c true

To run this script, enter the command:

guardianHeadless script -f activate.txt 

Here is an example of a script (evaluate.txt) that evaluates several domains:

evaluateDomainBundle -d guardian-dev_slp7_7001 -b 1 
evaluateDomainBundle -d guardian-dev_slp7_7001 -b 2 
evaluateDomainBundle -d guardian-dev2_slp8_7001 -b 0
evaluateDomainBundle -d guardian-qa_sqa-lldev_4044 
evaluateDomainBundle -d guardian-domain_slg-lldev_7001 -b 1
evaluateDomainBundle -d guardian-domain_slg-lldev_7001 -b 2
evaluateDomainBundle -d guardian-domain_slg-lldev_4401 
evaluateDomainBundle -d mydomain_mj23_32292

To run this script, enter the command:

guardianHeadless script -f evaluate.txt 

To review the results of script evaluations, use the Guardian Graphical User Interface. The 
Domain Explorer's Evaluation History folder contains an Evaluation Summary for each 
evaluation performed.

Scheduling Scripts
To schedule a script to run automatically at a specified time, you can use utilities such as the 
Windows Task Scheduler or the Linux crontab command. For example, to schedule the 
evaluate.txt script, you would schedule the command:
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guardianHeadless script -f evaluate.txt 

Recieving Notification
To recieve notification of detected signatures, create an evaluation script and use the Windows 
Task Scheduler or the Linux crontab command to schedule the script to run at regular intervals. 
Each time the script runs an evaluation, the signature.log file in the Guardian installation 
directory is updated with an entry that tells whether the signature was detected or not. You can 
set a third party management tool to scan that log for detected signatures and notify you when one 
is found.

Each signature.log entry starts with four number signs (####) and includes a time stamp. Each 
entry with a detected signature contains "<detected>" and is followed by a brief description which 
is also surrounded by "<>". The description includes the domain name. Following is a sample 
signature.log file:

####<Tue Aug 01 16:03:47 EDT 2006> <0> <g-dev_slp7_7001> <un> <0> 
<000022> <not detected> <Signature 000022 (Rotational Upgrade may 
cause java.io.StreamCorruptedException) not detected by username 
un evaluating bundle ID 0 in domain ID g-dev_slp7_7001.> 
####<Tue Aug 01 16:03:47 EDT 2006> <0> <g-dev_slp7_7001> <un> <0> 
<000027> <detected> <Signature 000027 (Native IO should be enabled 
in production mode for better performance) detected by username 
un evaluating bundle ID 0 in domain ID g-dev_slp7_7001.> 
####<Tue Aug 01 16:03:47 EDT 2006> <0> <g-dev_slp7_7001> <un> <0> 
<000055> <not detected> <Signature 000055 (JDK 1.5 is not 
certified for WebLogic 8.1) not detected by username un evaluating 
bundle ID 0 in domain ID g-dev_slp7_7001.> 

Related Concepts
Domain 

Evaluation 

Related Tasks
Activate Domain 
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Related Reference
Domain Explorer 

Evaluation Summary 

Related Getting Started
Starting and Using the Command Line Interface 

Starting the Graphical User Interface 

Installation 
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Interacting with the Graphical User Interface

BEA Guardian Main Window
The BEA Guardian Graphical User Interface consists of the following main components:

Main Title Bar - the uppermost region of the BEA Guardian Main Window. The Main Title 
Bar contains the BEA Guardian icon, the title, "BEA Guardian", and icons to minimize, 
maximize, restore, and close the window. You can double-click the Main Title Bar to 
maximize the window, and double-click it again to restore the window to its original size. 

Figure 1-14  Guardian Main Title Bar

You can right-click the Main Title Bar to open a pop-up menu with choices to Restore, 
Move, Size, Minimize, Maximize, and Close the BEA Guardian Main Window. Selecting 
Move or Size activates the arrow keys to move or resize the window to the location or size 
you want. Pressing an arrow key also makes the window move or resize in response to 
mouse pointer movement. Left-click to resume normal arrow key and mouse pointer 
operation. You can also move or resize the BEA Guardian Main Window with the mouse 
by dragging the title bar or window borders.

Figure 1-15  Guardian Main Title Bar Pop-up Menu

Main Menu - the menu headings below the Main Title Bar. You can open menus, navigate 
submenus, and select menu options with your mouse or keyboard. To use the keyboard, 
press the Alt key and type the menu selection key to open menus and select menu options. 
The menu selection key is the letter underlined in the menu after you press the Alt key. 
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Figure 1-16  Guardian Main Menu

Certain menu options also have keyboard shortcuts. With a keyboard shortcut, you only 
need to press a key sequence to select a menu option. To see the complete list of keyboard 
shortcuts, press "Ctrl+Shift+L".

Main Toolbar - the buttons with icons and text below the main menu. When the mouse 
pointer is over a toolbar button, a tool tip window pops up under the mouse pointer that 
says what the button does. 

Figure 1-17  Guardian Main Toolbar

Navigation Pane - the left hand region of the BEA Guardian window. The Navigation Pane 
contains these BEA Guardian views: 

Figure 1-18  Guardian Navigation Pane

– Bundle Explorer 

– Domain Explorer 

– Shortcut Explorer 

– Signature Explorer 
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You can have multiple views open at once, but only one of each kind. If you try to open 
one that's already open, it will be brought to the forefront of the Navigation Pane and made 
active.

Document Pane - the central region of the BEA Guardian window. The Document Pane is 
the location where these BEA Guardian views and editors open: 

Figure 1-19  Guardian Document Pane

– Active Domain Table 

– Bundle Details 

– Domain Inventory 

– Evaluation Summary 

– Shortcut Table 

– Signature Details 

You can have multiple views and editors open at once in the Document Pane. If you try to 
open one that's already open, it will be brought to the forefront of the Document Pane and 
made active. But you can create copies of an already open editor by selecting New Editor 
from the editor's System Menu.

View and Editor Title Bars
Each view and editor has its own title bar that contains its name, an identity icon, and icons to 
close, minimize, maximize, and restore.
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Figure 1-20  Guardian View and Editor Title Bar

You can double-click the title bar to maximize a view or editor, and double-click it again to 
restore the view or editor to its original size. You can also right-click the title bar to access the 
System Menu.

You can group multiple views or multiple editors together on a title bar as a tab group. Tab groups 
can be moved together as a unit, using either the System Menu's Move menu option or drop 
cursors. Only the title bar of the currently active view or editor is visible in a tab group.

Figure 1-21  Guardian View and Editor Tab Groups

If you have more views or editors open than can fit on a title bar, a Show List icon appears to the 
right of the title bar's tabs. The icon includes a number that indicates how many more views or 
editors are open than can fit on the title bar. Clicking the icon displays a list of all the title bar's 
views or editors. Selecting one brings it to the forefront of the Navigation Pane or Document Pane 
and makes it active. The ones listed in bold are the ones that cannot fit on the title bar. The ones 
not listed in bold are the ones that are already shown on the title bar.
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Figure 1-22  Guardian View and Editor Title Bar Show List

View and Editor Icons
Each view and editor has a set of icons in its title bar.

Icons Common to Both Views and Editors
These are the icons that both views and editors have in their title bar:

Icon Name Description

Close Closes a view or editor.

Minimize Shrinks a view or editor down to just its title bar and 
changes the Minimize icon into a Restore icon.

Maximize Expands a view or editor to the largest possible size and 
changes the Maximize icon into a Restore icon.

Restore Restores a minimized or maximized view or editor to its 
original size and location.

Show List Lists all the open views or editors on a title bar when there 
are too many to fit. The number indicates how many don't 
fit.
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Icons Common to Navigation Pane Views Only
These are the additional icons that the Domain Explorer, Bundle Explorer, and Signature 
Explorer have in their title bars:

View and Editor System Menus
Each view and editor has a System Menu, which you can access by right-clicking its title bar.

System Menu Options Common to Both Views and Editors
These are the System menu options that both views and editors have:

Icon Name Description

Expand all items Opens every folder and node in the Bundle Explorer or 
Domain Explorer.

Collapse all items Closes every folder and node in the Bundle Explorer or 
Domain Explorer so that only the top level folder is visible.

Menu Opens a menu with operations specific to the Bundle 
Explorer, Signature Explorer, and Domain Explorer for 
sorting and filtering signatures and domain information.

Link with Editor Synchronizes the editors open in the Document Pane with 
the Evaluation Summary and Domain Inventory entries in 
the Domain Explorer. When you bring an editor to the 
forefront of the Document Pane, the corresponding entry in 
the Domain Explorer is highlighted. And when you 
highlight an Evaluation Summary or Domain Inventory 
entry in the Domain Explorer, the corresponding editor in 
the Document Pane is brought to the forefront.

Name Description 

Restore Restores a minimized or maximized view or editor to its original size and 
location. 
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System Menu Options Common to Navigation Pane Views Only
These are the additional System menu options that only Navigation Pane views have:

System Menu Options Common to Document Pane Views and Editors Only
These are the additional System menu options that only Document Pane views and editors have:

Move Makes the mouse pointer active in moving views or editors to different 
locations. Move > View, moves just one view or editor. Move > Tab Group, 
moves all the views or editors sharing a title bar together. Left-click to resume 
normal mouse operation.

Size Makes the arrow keys active in resizing a view or editor. Select a direction 
(Left, Right, Top, Bottom) in which to grow or shrink. Left-click to resume 
normal arrow key operation. 

Minimize Shrinks a view or editor down to just its title bar and changes the Minimize 
icon into a Restore icon. 

Maximize Expands a view or editor to the largest possible size and changes the Maximize 
icon into a Restore icon. 

Close Closes a view or editor.

Name Description 

Detached Separate a view from the Navigation Pane so you can move it anywhere on 
your screen. To reattach the view, de-select the Detached menu option's check 
mark.

Name Description

Close Others Closes all the other views and editors currently open in the Document Pane, 
leaving the currently active view or editor open.

Close All Closes all the views and editors currently open in the Document Pane.

New Editor Creates a copy of the currently active view or editor in the Document Pane.
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View and Editor Drop Cursors
You can move views and editors by dragging their title bars to different locations. The views in 
the Navigation Pane can move almost anywhere, including outside the BEA Guardian window. 
But the editors can only move within the existing Document Pane.

As you drag a view or editor title bar, the mouse pointer changes into a drop cursor that indicates 
where the view or editor will appear when you release it. The drop cursor can change into any of 
these shapes:

Please note that where in the title bar you click determines what gets dragged. If you click the tab 
of a view or editor it will only move that view or editor, not the whole tab group. To grab the 
whole tab group, you have to click to the right of the tabs in the title bar, or use Move > Tab Group 
from the System Menu.

Drop Cursor Location Dragged Item Appears

Above what's under the drop cursor.

Below what's under the drop cursor.

To the right of what's under the drop cursor.

To the left of what's under the drop cursor.

As a tab in the title bar of what's under the drop cursor.

Outside the BEA Guardian window. To return it, de-select Detached from the 
System Menu.

Stays where it was, because the location is not valid.
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Dialog Boxes

Common Dialog Box Buttons and Icons
BEA Guardian uses dialog boxes to get information from you that's needed to perform certain 
operations. The Domain Properties, Signature Filters, Filter Domain Explorer, and Preferences 
dialog boxes have an OK button to accept the information you've provided and a Cancel button 
to exit the dialog box without performing any operations. They also have a close icon in their title 
bars to exit without performing any operations.

Figure 1-23  Guardian Domain Properties Dialog Box
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Preferences Page Title Bar
The Preferences page title bar has icons to maximize and restore the Preferences page. You can 
also double-click the Preferences page title bar to maximize it, and double-click it again to restore 
it to its original size.

You can right-click the Preferences page title bar to open a pop-up menu with choices to Restore, 
Move, Size, Maximize, or Close the Preferences page. Selecting Move or Size activates the arrow 
keys to move or resize it to the location or size you want. Pressing an arrow key also makes it 
move or resize in response to mouse pointer movement. Left-click to resume normal arrow key 
and mouse pointer operation. You can also move or resize the Preferences page with the mouse 
by dragging the title bar or window borders.

Figure 1-24  Guardian Preferences Title Bar

Select Workspace Dialog Box Title Bar
You can right-click the Select Workspace title bar title bar to open a pop-up menu with choices 
to Move, Size, or Close the Select Workspace dialog box. Selecting Move or Size activates the 
arrow keys to move or resize it to the location or size you want. Pressing an arrow key also makes 
it move or resize in response to mouse pointer movement. Left-click to resume normal arrow key 
and mouse pointer operation. You can also move or resize the Select Workspace dialog box with 
the mouse by dragging the title bar or window borders.

Figure 1-25  Guardian Select Workspace Title Bar
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Wizard Title Bar
You can right-click a Wizard's title bar to open a pop-up menu with choices to Move, Size, or 
Close the Wizard. Selecting Move or Size activates the arrow keys to move or resize it to the 
location or size you want. Pressing an arrow key also makes it move or resize in response to 
mouse pointer movement. Left-click to resume normal arrow key and mouse pointer operation. 
You can also move or resize a Wizard with the mouse by dragging the title bar or window borders.

Figure 1-26  Guardian Wizard Title Bar

Other Dialog Box Title Bars
You can right-click the Domain Properties, Signature Filters, and Filter Domain Explorer title 
bars to open a pop-up menu with choices to Move or Close the dialog box. Selecting Move 
activates the arrow keys to move it to the location you want. Pressing an arrow key also makes it 
move in response to mouse pointer movement. Left-click to resume normal arrow key and mouse 
pointer operation. You can also move these dialog boxes with the mouse by dragging the title bar.

Figure 1-27  Guardian Domain Properties Dialog Box Title Bar

Related Reference
Navigation Pane 

Bundle Explorer 

Domain Explorer 

Shortcut Explorer 

Signature Explorer 

Document Pane 

Active Domain Table 

Bundle Details 
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Domain Inventory

Evaluation Summary 

Shortcut Table 

Signature Details 

Wizards 

Domain Properties

Signature Filters 

Preferences 

Main Menu 

Main Toolbar 

Keyboard Shortcuts 

Related Getting Started
Starting the Graphical User Interface 
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Release Notes/Known Issues
The Release Notes/Knows Issues list all the deviations from specification you may encounter 
when installing and running Guardian.

WebLogic Server Issues

CR288424: Manual Guardian Agent deployment required for WLS 9.0 domains
This problems affects Guardian activations of WebLogic Server 9.0 domains only (not 
subsequent 9.x versions).

Due to an error in WebLogic Server 9.0, the automatic deployment of the Guardian Agent during 
domain activation does not work. The result is that you have to manually deploy the Guardian 
Agent to the Administration Server and all Managed Servers before you can evaluate WLS 9.0 
domains.

For an overview of how to deploy the Guardian Agent manually, see the Manually Deploy 
Guardian Agent document. For more information on installing and starting web applications, go 
to the BEA eDocs website:

Installing a Web Application 

Starting a Web Application 

Three WLS 9.0 patches needed for Guardian to evaluate WLS 9.0 domains 
properly:
These problems affect Guardian evaluations of WebLogic Server 9.0 domains only (not 
subsequent 9.x versions).

CR236877: Temporary patches not listed in WLS 9.0 

Due to an error in WebLogic Server 9.0, Guardian is unable to determine what patches 
have been installed. Some of Guardian's signatures depend on being able to identify what 
patches you have to determine what patches you may still need. The result is that Guardian 
may falsely report that you need certain patches when you already have them. In order for 
Guardian to evaluate WLS 9.0 domains properly, please contact BEA Support to get the 
patch for CR236877.

CR297395: JMX data unavailable for Managed Servers on WLS 9.0 
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Due to an error in WebLogic Server 9.0, Guardian is unable to collect Java Management 
Extensions (JMX) data from the Managed Servers in multi-server domains. Although data 
is available for the Administration Server, some of Guardian's signatures depend on data 
gathered from all the servers in a multi-domain environment. The result is that Guardian 
may miss potential problems that it would have otherwise detected. In order for Guardian 
to evaluate WLS 9.0 domains properly, please contact BEA Support to get the patch for 
CR297395.

CR297411: Another multi-server domain data collection problem uncovered by patch for 
CR297395 

The patch to fix CR297395 revealed another error in WebLogic Server 9.0 that also causes 
difficulties for Guardian in evaluating multi-server domains. In order for Guardian to 
evaluate WLS 9.0 domains properly, please contact BEA Support to get the patch for 
CR297411.

CR284362: Activation of WLS 8.1 domains can generate domain console 
error
Due to an error in WebLogic Server 8.1 Service Pack 6 and 7, Guardian's domain activation can 
cause a Java NullPointerException error to be logged to the WLS console. The domain still 
activates successfully, though. This error is due to Guardian running a 
ServerRuntime.getClusterRuntime() operation on a server that does not belong to a cluster. To 
stop this error from being logged, please contact BEA Support to get the patch for CR284362.

SSL Issues
Please note that Guardian uses 128 bit open source encryption for SSL. Using this level of 
encryption may require you to take additional action to be in compliance with your 
country’s import requirements. 

CR298107: Strong encryption SSL requires copying BEA license file
In order to use SSL with strong encryption, you must copy the license.bea file from your 
WebLogic Server installation directory to your Guardian installation directory. That is, the same 
directory where the guardian.exe executable resides, which you specified when you 
installed Guardian. If there's more than one license.bea, make sure you select the one that has a 
component field containing the word, domestic; for example, 
component="Encryption/Domestic", or component="SSL/Domestic"
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CR304572: Guardian does not support SSL for WLS 8.1 SP2 and earlier
Guardian does not support Secure Sockets Layer (SSL) encryption on WebLogic Server version 
8.1 with Service Pack 2. Prior versions of WebLogic Server 8.1 are also not supported. This 
limitation is due to differences in the jdk javax.crypto.Cipher package in the jdk. In order for 
Guardian to use SSL, please upgrade to WebLogic Server version 8.1 Service Pack 3 or above.

CR284901: Using your own Trusted Authority requires importing root 
certificate into cacerts
Activating a domain using SSL with a certificate that is signed by a non-standard certificate 
authority incurs an exception and fails. The error message is:

ERROR DomainActivationWizard [ModalContext] :
ControllerException 
com.bea.guardian.controller.ControllerException:
GuardianEngineException thrown. at
com.bea.guardian.controller.ControllerImpl.activateDomain(Unknow
n Source) at
com.bea.support.guardian.ui.wizards.DomainActivationWizard$Activ
ateDomain$1.run (Unknown Source) at
org.eclipse.jface.operation.ModalContext$ModalContextThread.run(
ModalContext.java:113)
Caused by: com.bea.guardian.collection.CollectionException:
javax.net.ssl.SSLHandshakeException:
sun.security.validator.ValidatorException: PKIX path building 
failed:
sun.security.provider.certpath.SunCertPathBuilderException: 
unable to
find valid certification path to requested target

A non-standard certificate authority can be trusted once the root certificate of the non-standard 
certificate authority has been imported into the cacerts file. If you are using SSL for Guardian and 
have your own Trusted Authority, you must import the root certificate into your cacerts. 
Following are the steps to import your Trusted Root Certificate:

Your cacerts file is located in <JRE_INSTALL>/jre##.##/lib/security/cacerts. 
To find the location of your JRE install, start Guardian, go to Help>About BEA Guardian and 
click the Configuration Details button. That will display the java.home that points to your JRE 
install directory. 
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Download your Trusted Root Certificate (obtained by your Administrator) and place it in the 
same directory as the cacerts. Example: 
<JRE_INSTALL>/jre##.##/lib/security/myroot.pem. 

Run the <JRE_INSTALL>/jre##.##/bin/keytool command to import your Trusted 
Root Certificate into the cacerts.
Example: keytool -import -v -file myroot.pem -keystore 
"<JRE_INSTALL>/jre##.##/lib/security/
cacerts" -storepass changeit -alias myroot
For more information about the keytool command, please go to:
http://docs.sun.com/app/docs/doc/817-0798/6mgisnq6m?a=view 

Restart Guardian and activate your domain. 

CR288425: Guardian does not use SSL to install Guardian Agent
Guardian does not use Secure Sockets Layer (SSL) encryption to install the Guardian Agent on 
the domain during domain activation, even if you select the https:// protocol in the Domain 
Activation Wizard. The other parts of the domain activation do use SSL. Please note that no user 
data is transmitted when installing the Guardian Agent.

CR288428: Guardian only supports one-way SSL, not two-way
One-way SSL sets up a secure connection between a web server and client by requiring the server 
to present a digital certificate to its clients and by encrypting the data passed between the client 
and server. It provides authentication of the server, but not the client. With two-way SSL, the 
server presents a digital certificate to the client, as with one-way SSL. But with two-way SSL, the 
client must also present a digital certificate to the server before the SSL session is established.

Browser Issues

CR294468: Mozilla installation required for Guardian on Linux
The Evaluation Summary display is blank in Linux when Mozilla is not installed. You can still 
use another browser, such as Firefox, but you need to have Mozilla installed.

On Linux, Eclipse seems to expect to find some libraries that are a part of Mozilla for rendering 
HTML/XML. This is releated to Eclipses' use of native libraries for rendering widgets and 
controls. If you encounter this issue, please take the following steps to resolve it:

Install mozilla in /usr/lib/mozilla and make sure that /usr/lib/mozilla/libxpcom.so is there. 
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Edit the /etc/ld.so.conf and add /usr/lib/mozilla. 

Run ldconfig as root to get the libpath updated. 

Restart guardian and everything should work. 

CR289181: Guardian Welcome Page does not display correctly with Internet 
Explorer 7
The Guardian icons are not displayed on the Welcome Page when Internet Explorer Version 7 is 
your default browser. To enable hypertext links in the Welcome Page and editor report pages, 
Guardian inherits certain attributes from your default browser. With IE7 and Eclipse 3.1 (on 
which Guardian is based), this leads to problems with the Welcome Page display.

Miscellaneous Issues

CR294752: Guardian requires write access to temp directory
Guardian on both Windows and Linux requires write access to temp directories. On Windows, 
the \temp directory of the drive where you installed installed Guardian needs to be write enabled 
for Guardian to operate properly. In Linux, the /tmp directory needs to be write enabled. This is 
particularly important when using Guardian to create BEA support cases.

CR287157: Select Workspace does not display new folder name
When Guardian starts, it prompts you for the workspace folder with the "Select Workspace" 
dialog box. If you click the "Browse" button to select a folder for the workspace, Guardian opens 
the "Browse for Folder" dialog box. If you then click the "Make New Folder" button and type in 
a new folder name, that name is not displayed in the "Folder:" text box. However, the new folder 
you typed in has been selected. If you click the "OK" button, the new folder you just created will 
be displayed as the workspace in the "Select Workspace" dialog box.

CR271497: Unhelpful error message on remote execution failure
If Guardian fails to run remotely, the error message is not very informative. If you copy a 
Guardian installation directory to a remote machine's shared folder and try to run it and it fails 
(for example, due to insufficient privileges), the error message is "An error has occurred, see the 
log file, [log file path]". But the log file does not contain any additional information. Please note 
that you can run Guardian from a remote machine's shared folder, you just need to make sure you 
have write access to the workspace directory you specify.
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Related Reference
Manually Deploy Guardian Agent 

Related Getting Started
Installation 
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Frequently Asked Questions

Running Guardian with pre-V5 Java
Q: What happens if I run BEA Guardian in a Java Runtime Environment that's earlier than version 
5 (also known as version 1.5) ?

A: Guardian will not start on a machine that is running a JRE older than version 5 (also known 
as version 1.5). If you attempt to run Guardian with an older JRE, you will get an error message 
such as, Could not create the Java virtual machine, or process 
terminated. See Supported Configurations for more details.

Please note that you can use Guardian to evaluate domains that are running an older JRE. See 
Supported Targets for more details. You can download the latest Java Runtime Environment from 
java.com.

Running Guardian with Multiple Java Versions Installed
Q: I have more than one version of Java Runtime Environment installed, but Guardian can only 
use version 5 (also known as 1.5). How do I tell Guardian which Java Runtime Environment to 
use ?

A: You can tell Guardian which JRE to use with any one of the following methods (substituting 
your actual JRE directory path for the one shown in the example):

Edit guardian.ini (in the Guardian installation directory) and add the following two lines: 
-vm
c:\jre_1.5\bin\java.exe 

Start the Guardian Graphical User Interface from the command line with the -vm 
argument: 
guardian -vm c:\jre_1.5\bin\java.exe 

Create a Windows Shortcut to Guardian, right-click it to edit its Properties, and append the 
following to the existing Target property in the Shortcut tab:
-vm c:\jre_1.5\bin\java.exe 

Running Guardian without an Internet Connection
Q: How can I download signatures and application updates or open support cases if my computer 
is not connected to the Internet for security reasons ?
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A: To get the latest signatures from BEA, install Guardian on a computer that is connected to the 
Internet, click the Update button to download the signatures JAR file to the <installation 
directory>/repository/archives directory, and then manually copy it to the same directory on your 
secure computer. You’ll have to restart Guardian for the changes to take affect.

To get the latest application updates from BEA, install Guardian on a computer that is connected 
to the Internet, click the Update button to download the latest application updates to the 
<installation directory>/features and <installation directory>/plugins directories, and then 
manually copy those directories to the same locations on your secure computer. You’ll have to 
restart Guardian for the changes to take affect.

To create support cases, run the Support Case Wizard, select the Save Case Creation Archive 
option in the Select Case Destination dialog box, and then go to a computer that is connected to 
the Internet, open a support case on the BEA eSupport web site, and include the .CAR case 
archive file as an attachment. The .CAR case archive file is created by the Support Case Wizard. 
Although you specify its location, BEA recommends saving it in the Case Creation Archives sub 
directory of the Guardian Workspace directory you specified when you started Guardian.

SSL Encryption
Q: What kind of encryption does Guardian use ?

A: Guardian uses 128 bit open source encryption for SSL. Please note that using this level of 
encryption may require you to take additional action to be in compliance with your country’s 
import requirements. 

License Validation Error
Q: What should I do if I get an error message that says, “Exception ocurred while reading the 
license file” when starting Guardian ?

A: Although the evaluation version of Guardian is free for 60 days, it still requires a valid BEA 
license. To get this license, go to the BEA Guardian downloads page and right-click the 
“Download License Key Here’ link. From the right-click pop-up menu, select “Save Target As”, 
and save the license key file as “license.bea”. Please note that the file name, “license.bea”, is 
different than the default “Save As” file name, “license.xml”. Also note that you need to save the 
“license.bea” file to the Guardian Installation directory where you installed Guardian. Then you 
can restart Guardian without getting a license validation error.
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Evaluations with Servers Down
Q: What happens if some of my servers are down during an evaluation ?

A: Guardian cannot perform an evaluation if the domain's Administration Server is unavailable. 
If the Administration Server is available, and some of the Managed Servers are unavailable, 
Guardian can perform an evaluation. But, the domain data missing from these Managed Servers 
could cause the evaluation to miss potential problems. BEA recommends performing evaluations 
with all of the target domain's servers up and running.

Operating Systems
Q: On which operating systems does the Guardian user interface run ?

A: The Guardian user interface runs on Windows and Linux. But, Guardian can evaluate domains 
running on any operating system that BEA WebLogic supports.

Domain Inventories
Q: What's in a Domain Inventory ?

A: The Domain Inventory includes descriptions of your servers, Java Virtual Machines, operating 
systems, and databases. The descriptions include product versions as well as some configuration 
settings. The Domain Inventory data comes from Guardian Agents installed on the domain that 
collect Java Management Extension (JMX) data, Java system properties, and database metadata 
for your JDBC connection pools.

Change Management
Q: Can Guardian be used for change management - moving from Development to QA to 
Production ?

A: Yes. BEA recommends using Guardian at each stage of your development cycle, as described 
in the Usage Scenarios. As you move to each new stage, run an evaluation to take advantage of 
BEA's known best practices. The Guardian development team is considering additional 
functionality to aid in change management for a future release.

Installation of Patches
Q: Does Guardian automatically push patches out to the Managed Servers of a domain as well as 
the Administration Server ?
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A: Guardian does not install patches to any server. Guardian recommends actions, such as 
installing patches, but it is up to the user to implement them.

Guardian Command Line Interface
Q: What is the command line interface? Is it the WebLogic Scripting Tool (WLST) ?

A: No. The Guardian Command Line Interface is just a wrapper around the Java command.

Scheduling Command Line Interface scripts
Q: Why doesn't Guardian include functionality to schedule command line scripts instead of 
leaving it up to the operating system, with commands such as crontab, or the Windows Task 
Scheduler ?

A: The Guardian development team decided to leave it up to the users to schedule scripts so they 
could monitor the output with their favorite management applications. The Guardian team is 
considering adding scheduling capabilities in a future release.

Ignoring Detected Signatures
Q: Does Guardian have "ignore" or "remind me later" features for the signatures detected in an 
evaluation ?

A: No. The Guardian development team is considering adding those features in a future release.

Deleting Signatures
Q: Can I delete signatures ?

A: To improve performance and save disk space, Guardian's signatures are kept in a Java Archive 
(.jar) file in the repository/archive directory of the Guardian installation directory. While you 
could delete signatures from that archive, BEA recommends not deleting signatures for the 
following reasons:

Deleting signatures provides no real benefit. Before each evaluation, Guardian creates a 
Domain Inventory to determine which signatures are applicable to the target domain. Any 
signatures that aren't relevant aren't evaluated, so there's virtually no performance benefit 
to deleting them. 

If your domain changes, signatures that weren't applicable to your domain before may 
become applicable. Deleting those signatures would prevent them from being used in any 
future evaluations and reduce Guardian's effectiveness. 
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If you download new signatures, the signatures you deleted will be replaced. Any deletions 
are likely to be undone in the normal course of Guardian operations. 

Multiple BEA Site Identifiers
Q: What should I do if I have multiple BEA Support site licenses ?

A: BEA recommends using one instance of Guardian per site license identifier. If you have a set 
of domains using one site license and want to evaluate them with Guardian, use an installation 
instance of Guardian that's set to use that site identifier. If you have another set of domains with 
a different site license identifier, use another installation instance of Guardian set to use that site 
identifier. Using separate instances of Guardian for each site identifier will make it easier to keep 
track of any support cases you may create.

Integration with WebLogic Administration Consoles
Q: Why isn't Guardian integrated with the WebLogic Administration Console ?

A: One installation of Guardian can evaluate many domains. Because WebLogic Administration 
Consoles manage one domain at a time, integrating Guardian with the console would limit 
Guardian's ability to evaluate muliple domains.

Web Interface
Q: Does Guardian have a Web interface ?

A: No. Guardian has an Eclipse Rich Client Platform (RCP) based Graphical User Interface and 
a Command Line Interface.

BEA Smart Update
Q: Does Guardian work in conjunction with BEA Smart Update ?

A: No. Guardian will be integrating with BEA Smart Update in a future release to help customers 
download the patches recommended by Guardian signatures.

Integration with WLDF
Q: How does Guardian work with the WebLogic Diagnostic Framework (WLDF) ?

A: Guardian does not currently integrate with WLDF, but the Guardian development team is 
considering it for a future release.
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Related Concepts
Evaluation 

Domain 

Guardian Agent

Signature 

Related Tasks
Submit Support Case 

Update Guardian 

Related Getting Started
Installation 

Supported Configurations 

Supported Targets 

Usage Scenarios 

Starting the Graphical User Interface 



BEA Guardian User Guide 2-1

C H A P T E R 2

Concepts

Evaluation
To identify potential problems before they occur, BEA Guardian conducts an evaluation. An 
evaluation searches for signatures in your domain.

The key inputs for the evaluation are groups of signatures, called bundles, and domains. Bundles 
determine what patterns to look for; the domain determines where to look.

The Guardian Agent collects the domain data used to detect signatures. An agent is installed on 
each server in the domain.

When the evaluation is complete, the results are displayed in the Evaluation Summary. The 
Evaluation Summary includes descriptions and remedy recommendations for each signature 
detected.

Because it both detects potential problems and guides you on how to correct them, the evaluation 
is the principal function of BEA Guardian.

Related Concepts
Signature 

Domain 

Bundle 

Guardian Agent 



Concepts

2-2 BEA Guardian User Guide

Related Tasks
Evaluate Domain 

Activate Domain 

Related Reference
Evaluation Wizard 

Evaluation Summary 
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Domain
A domain is a logically related group of WebLogic Server resources that you manage as a unit. 
A domain always includes at least one WebLogic Server instance called the Administration 
Server. The Administration Server acts as a central point of contact for server instances and 
system administration tools. A domain may also include additional WebLogic Server instances 
called Managed Servers.

Each BEA Guardian installation maintains a registry of active domains. A domain is considered 
active when it is capable of being evaluated. You select which domains to activate and evaluate.

Related Concepts
Guardian Registry 

Evaluation 

Domain Inventory 

Related Tasks
Activate Domain 

Evaluate Domain 

Modify Domain 

Deactivate Domain 

Related Reference
Domain Explorer 

Active Domain Table 

Domain Inventory 

Domain Activation Wizard 

Domain Deactivation Wizard
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Signature
BEA Support has identified patterns in user domains that can cause problems. These patterns are 
described in XML documents called signatures.

Signatures describe potential problems based on information about your BEA WebLogic servers 
and the environment in which they are deployed, including Java Virtual Machines (JVMs), 
operating systems, and databases. Signatures can identify specific versions of these products as 
well as their configuration settings.

In addition to the potential problem description, signatures also contain a remedy 
recommendation and a severity level: 1-Critical, 2-Warning, or 3-Info.

To detect signatures in your domain, you conduct an evaluation. When the evaluation is 
complete, the results are displayed in the Evaluation Summary. The Evaluation Summary lists all 
the signatures detected with their severity level, description, and remedy recommendation.

The signature is the critical component of BEA Guardian because it contains the distilled 
knowledge of BEA Support for both detecting potential problems and resolving them.

Related Concepts
Domain 

Evaluation 

Bundle 

Related Tasks
Evaluate Domain 

Update Guardian

Related Reference
Signature Explorer 

Signature Details 

Signature Log File 

Evaluation Summary 
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Bundle
A bundle is a group of signatures that are evaluated together. You select which bundle to evaluate 
on which domain. Bundles determine what signatures to look for; the domain determines where 
to look.

Related Concepts
Signature 

Evaluation 

Domain 

Related Tasks
Evaluate Domain 

Related Reference
Bundle Explorer 

Bundle Details 
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Guardian Agent
The Guardian Agent collects data from your domain. This data is used during an evaluation to 
detect signatures that can cause problems in your domain.

The Guardian Agent uses Java Management Extensions (JMX), Java System Properties, and 
JDBC drivers to collect the data required by the signatures. To access this data, a Guardian Agent 
may be installed on each server in the domain during domain activation. If you have configured 
additional servers in your domain since activation, additional Guardian Agents may be installed 
during evaluation.

See Security & Privacy for information on securing the communication between BEA Guardian 
and the Guardian Agents in your domain.

Related Concepts
Domain 

Evaluation 

Signature 

Security & Privacy 

Related Tasks
Activate Domain 

Evaluate Domain 

Related Reference
Domain Activation Wizard
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Shortcut
If you will be repeatedly evaluating a domain with the same signature bundle, a shortcut will save 
time and effort. Shortcuts reduce the number of steps it takes to conduct an evaluation.

Ordinarily, to conduct an evaluation, you would run the Evaluation Wizard and select the domain 
and signature bundle to evaluate. But when you create a shortcut, you preselect the domain and 
signature bundle. Then whenever you invoke that shortcut, the Evaluation Wizard opens with the 
domain and bundle already selected.

Related Concepts
Evaluation 

Domain 

Bundle 

Signature 

Related Tasks
Create Shortcut

Delete Shortcut 

Evaluate Domain 

Related Reference
Shortcut Wizard 

Shortcut Explorer 

Shortcut Table 

Evaluation Wizard 
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Support Case
A Support Case is a record created in submitting technical questions or issues to BEA Support. 
Customers with a support contract can open a support case on BEA's eSupport website and over 
the phone.

Now you can also open a support case with BEA Guardian. When you conduct an evaluation that 
detects a signature, you can submit a support case directly from the Evaluation Summary. 
Guardian automatically creates the case with all the signature specific information needed for a 
BEA support engineer to begin working on it right away. You can also add any additional 
attachments and notes before sending it to BEA.

If you choose not to open a support case, you can instead save the case information as a Case 
Creation Archive. Case Creation Archives are stored as files with the extension, .car, in the 
data/<domain node>/Case Creation Archives folder of the Guardian Workspace 
location you specified when you started Guardian.

To learn more about BEA Support and support cases, please go to the eSupport website and 
download the BEA Customer Support Guidebook.

Related Concepts
Evaluation 

Signature 

Guardian Workspace 

Related Tasks
Submit Support Case 

Evaluate Domain 

Related Reference
Support Case Wizard 

Evaluation Summary 

Domain Explorer 
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Related Getting Started
Starting the Graphical User Interface
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Security & Privacy

Security

Authentication
All communication between BEA Guardian and servers in the target domain requires valid 
username and password credentials. BEA Guardian prompts you for the username and password 
of an administrator account on the target domain when you conduct an evaluation or activate a 
domain. You can choose to have BEA Guardian remember the username and password so you 
won't have to enter them for every evaluation.

Data Encryption
All passwords persisted on disk are encrypted. Usernames and server names are also encrypted. 
This encryption helps prevent the disclosure of any clear text data that could compromise the 
security of your domain.

Secure Transmission
Secure Sockets Layer (SSL) encryption is available for all communication with BEA over the 
Internet and all communication with Guardian Agents in your target domain. Please note that 
Guardian uses 128 bit open source encryption for SSL. If you want to use SSL, there are three 
types of communication to consider:

Target domain communication - to set SSL encryption for communication between BEA 
Guardian and your target domain during domain activation and evaluation, select the https:// 
communications protocol in the Domain Activation Wizard. 

Signature downloads - to set SSL encryption for downloading signatures from BEA 
Support, select Require SSL in your BEA Guardian Preferences. This will also set SSL 
encryption for uploading signature usage statistics (see Privacy below). 

Support case creation - to set SSL encryption for opening support cases with BEA Support, 
select Require SSL in your BEA Guardian Preferences. 

Privacy
When you download signatures from BEA Support, BEA collects high level statistics about your 
signature usage, including the number of times each signature was evaluated and detected. No 
customer data is included in the usage statistics. This information is only used in aggregate to 
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assess each signature's effectiveness and is crucial to the continuous improvement of BEA 
Guardian.

Following is a sample signature usage statistic:

"signature id" is the unique identifier for the signature 

"type" is the category of signature used 

"fired" is how many times the signature was considered for use (and includes times it was 
disqualified before evaluation due to targeting products not present on the domain) 

"evaluated" is how many times the signature was actually compared to the target domain 

"detected" is how many times the signature was actually found on the target domain 

<?xml version="1.0" encoding="UTF-8"?>
<usage>
<signature id="WAR0001.001" type="Evaluation" fired="30" 
evaluated="18" detected="2" />
<signature id="ADMIN0001.001" type="Evaluation" fired="30" 
evaluated="20" detected="1" />
</usage>

Related Concepts
Domain 

Evaluation 

Guardian Agent 

Signature 

Support Case

Related Tasks
Activate Domain 

Update Guardian

Related Reference
Domain Activation Wizard 
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Preferences 
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Domain Inventory
The Domain Inventory is an XML document describing the products in your domain. It includes 
descriptions of your servers, Java Virtual Machines, operating systems, and databases. The 
descriptions include product versions as well as some configuration settings.

A Domain Inventory is created when you activate a domain and is refreshed each time a domain 
is evaluated. You can also invoke Inventory Wizard yourself to create a new domain inventory. 
Domain Inventories are kept in the Guardian Workspace.

The Domain Explorer lists the inventories for each domain. You can see the inventory details in 
the Domain Inventory editor.

Related Concepts
Domain 

Evaluation 

Guardian Workspace

Related Tasks
Activate Domain

Evaluate Domain 

Related Reference
Inventory Wizard 

Domain Explorer 

Domain Inventory
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Guardian Workspace
The Guardian Workspace is the directory where your work is stored. It includes the Domain 
Inventories, Evaluation Summaries, and Case Archives for each domain that you activate, 
inventory, evaluate, and create support cases for.

Although you select the Guardian Workspace location, it must be separate from the Guardian 
installation directory where the BEA Guardian executable, Signature Repository, Guardian 
Registry, and other application files reside. This requirement preserves the implicit contract with 
the customer that their data will never be removed, even during uninstallation.

Although the documents in the Guardian Workspace are persisted as XML files, they are best 
viewed through the Guardian Graphical User Interface. Using the Guardian Graphical User 
Interface allows both better formatting and better protection against unintended edits or deletions.

Related Concepts
Domain Inventory 

Domain 

Signature Repository 

Guardian Registry 

Related Tasks
Activate Domain 

Inventory Domain 

Evaluate Domain

Submit Support Case 

Related Reference
Domain Inventory 

Evaluation Summary 

Related Getting Started
Installation 
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Guardian Registry
The Guardian Registry is an XML document created during product installation that keeps track 
of your specific BEA Guardian configuration. The Guardian Registry includes the domains 
you've activated, the bundles available for evaluation, the shortcuts you've defined, and the 
Guardian Workspace location.

The Guardian Registry is updated each time a domain or shortcut is added, edited or deleted.

Related Concepts
Domain 

Bundle 

Evaluation 

Shortcut 

Guardian Workspace 

Related Tasks
Activate Domain 
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Signature Repository
The Signature Repository is where BEA Guardian keeps its locally persisted store of signatures 
available for evaluation. When you download signatures from the Guardian update site, they 
arrive in a Java Archive (JAR) file. The JAR file is stored in the repository/archives 
directory of your Guardian installation directory.

Related Concepts
Signature 

Evaluation 

Related Tasks
Update Guardian 

Related Getting Started
Installation 
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Tasks

Activate Domain
A domain is considered active when it is capable of being evaluated. Activating a domain 
prepares it for evaluation by installing any needed Guardian Agents and creating a new Domain 
Inventory.

You use the Domain Activation Wizard to activate a domain. There are several different ways to 
invoke the Domain Activation Wizard:

Press Ctrl+Shift+A. 

Click the Activate button on the Main Toolbar. 

Select New > Domain from the File menu. 

Right-click inside the Domain Explorer and select Activate Domain from the pop-up 
context menu. 

The Domain Activation Wizard prompts you for:

The communication protocol - either http:// or https:// for Secure Sockets Layer (SSL) 
encryption. Please note that Guardian does not use 128 bit SSL encryption for domain 
activation.

The host name - the listen address of the target domain's administration server, for 
example, localhost, 66.248.193.194, or guardian-dev.bea.com 

The port number - the listen port for the target domain's Administration Server 
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The login credentials - the username and password of an administrator account on the 
target domain 

The credentials' persistence - an option to remember the username and password for future 
evaluations and other Guardian domain operations 

The proxy connection - an option to use a proxy server to access the target domain 

To use a proxy connection, you must first manually deploy the Guardian Agent onto the target 
domain. Then you must add the proxy server to the Domain Activation Wizard's proxy server 
drop down list. Then check the Enable proxy connection checkbox, and select the proxy server 
from the drop down list.

Once started, the Domain Activation Wizard connects to the Administration Server to install 
Guardian Agents on the domain's servers. It also creates a Domain Inventory and adds the domain 
to the Domain Explorer and the Active Domain Table. Once complete, the domain is considered 
active and ready for evaluation.

Related Concepts
Domain 

Evaluation 

Guardian Agent 

Domain Inventory 

Security & Privacy 

Related Tasks
Deactivate Domain 

Related Reference
Domain Activation Wizard 

Domain Explorer 

Manually Deploy Guardian Agent 

Add Proxy Servers 

Active Domain Table 
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Keyboard Shortcuts 

Main Toolbar 

Main Menu 
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Deactivate Domain
When you deactivate a domain, it is no longer available for evaluation. If you later decide you 
want to evaluate it, you must first activate it again.

You use the Domain Deactivation Wizard to deactivate a domain. There are two different ways 
to invoke the Domain Deactivation Wizard:

Select a domain in the Active Domain Table and click the Deactivate Domain button. 

Right-click a domain in the Domain Explorer and select Deactivate from the pop-up 
context menu. 

The Domain Deactivation Wizard shows the domain selected when invoked. To deactivate it, 
click the Finish button. If you decide not to deactivate the domain, click the Cancel button 
instead.

When the deactivation completes, the domain remains in the Domain Explorer so that you can 
continue to access its previous Domain Inventories and Evaluation Summaries. But any shortcuts 
that use the domain are removed from the Shortcut Table and Shortcut Explorer.

To remove a deactivated domain from the Domain Explorer, select Purge Inactive Domains from 
the Tools menu. Purge Inactive Domains also deletes the Domain Inventories and Evaluation 
Summaries from the Guardian Workspace and removes the domain from the Guardian Registry.

Please note that the Domain Deactivation Wizard does not remove the BEA Guardian Agents that 
were installed during domain activation. To remove them manually, use the deployment tools 
provided with WebLogic Server. Guardian Agents are deployed as Web Application Archive 
(WAR) files with the name, "bea-guardian-agent". Deployment documentation can be found on 
the BEA eDocs website for:

BEA WebLogic Server 8.1 

BEA WebLogic Server 9.1 

BEA WebLogic Server 9.2 

Related Concepts
Evaluation 

Domain 

Guardian Workspace 



Act iva te  Domain

BEA Guardian User Guide 3-5

Guardian Registry 

Guardian Agent

Related Tasks
Activate Domain

Related Reference
Domain Deactivation Wizard 

Active Domain Table 

Domain Explorer 

Shortcut Explorer 

Shortcut Table 

Domain Inventory 

Evaluation Summary 
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Evaluate Domain
To identify potential problems before they occur, you evaluate a domain with the Evaluation 
Wizard. You can select multiple domains for concurrent evaluation. There are several different 
ways to invoke the Evaluation Wizard:

Press Ctrl+Shift+E. 

Click the Evaluate button on the Main Toolbar. 

Select New > Evaluation from the File menu. 

Double-click a domain in the Active Domain Table. 

Double-click a domain in the Domain Explorer. 

Right-click a domain in the Domain Explorer, or anywhere in the Domain Explorer, and 
select Evaluate from the pop-up context menu. 

The Evaluation Wizard allows you to select the domain to target and the signature bundle to 
evaluate. It also prompts you for an administrator account username and password on the target 
domain. If you selected the option to remember the username and password when activating or 
modifying the target domain, the username and password will already be filled in.

If a domain is selected and the Domain Explorer or Active Domain Table is active when the 
Evaluation Wizard is invoked, it will assume that is the domain you want to target for the 
evaluation and start with that domain already selected.

When the evaluation is complete, you can view the results in the Evaluation Summary.

Related Concepts
Domain 

Evaluation 

Bundle 

Related Tasks
Activate Domain 

Modify Domain
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Related Reference
Evaluation Wizard 

Active Domain Table 

Domain Explorer 

Evaluation Summary 

Keyboard Shortcuts 

Main Toolbar 

Main Menu 
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Submit Support Case
To submit a support case, invoke the Support Case Wizard from an Evaluation Summary by 
clicking the Get more help from BEA support link. You can open an Evaluation Summary either 
by performing an evaluation, or double-clicking an Evaluation Summary entry in the Domain 
Explorer.

The Support Case Wizard uses a sequence of dialog boxes to gather the information needed to 
open a support case and allow a BEA support engineer to begin working on it. The Support Case 
Wizard steps are:

Select Server Node - Identify the server to be used to gather the domain's environment 
information for the support case, typically the Administration Server. 

Support Case Notes - Add any additional text that you feel may be helpful to BEA in 
resolving the support case. 

Select Case Attachments - Specify which background information files will be sent to 
BEA, for example, the server log or the domain configuration file. Each signature identifies 
the background information needed to resolve the case. You can either submit the files the 
signature recommends, choose not to submit them, or add additional files. By submitting 
the recommended background materials now, you allow the BEA support engineer to begin 
working on the case sooner. 

Domain Login - Enter the username and password to login to the domain where the 
signature was detected. If you earlier selected Remember username/password in the 
Domain Activation Wizard, they will already be filled in for you. 

Select Case Destination - Decide whether to connect to BEA and upload the support case 
now, or save it as a Case Archive for uploading later. If you choose to save it as a Case 
Archive, you have to select the Case Creation Archives folder to save the Case Archive in 
before proceeding. The Case Creation Archives folder is in the Guardian Workspace under 
the folder created for each domain during activation. 

eSupport Login - Enter your eSupport username and password. This allows Guardian to 
login to the eSupport website to create the support case. 

When the eSupport login is entered, you can click the Finish button to either submit the 
support case to BEA, or save it as an archive for later submission. 

Related Concepts
Evaluation 



Act iva te  Domain

BEA Guardian User Guide 3-9

Support Case 

Signature 

Guardian Workspace 

Related Reference
Support Case Wizard 

Evaluation Summary 

Domain Explorer 

Domain Activation Wizard 
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Modify Domain
Modifying a domain allows you to modify the way BEA Guardian communicates with the 
domains you have activated. You use the Domain Properties dialog box to modify a domain. It 
can be opened in any of the following ways:

Select a domain from the Active Domain Table and click the Modify Domain button. 

Right-click a domain in the Domain Explorer and select Modify Domain from the pop-up 
context menu. 

The Domain Properties dialog box allows you to change the following aspects of Guardian's 
communication with a target domain:

The administrator account username and password Guardian uses to access the domain - 
please note that changing the username and password in Guardian does not change the 
username and password on the domain. 

Whether to remember the username and password - if selected, the username and password 
are encrypted and stored on disk. Then, whenever Guardian needs to access the domain, 
the domain's username and password are filled in automatically. Otherwise, you have to 
enter them for each operation that accesses the domain. 

Whether to use a proxy server to access the domain - if selected, you must add a proxy 
server and manually deploy the Guardian Agent onto the target domain. 

Related Concepts
Domain 

Security & Privacy 

Related Tasks
Activate Domain 

Inventory Domain 

Evaluate Domain 

Related Reference
Domain Properties 



Act iva te  Domain

BEA Guardian User Guide 3-11

Active Domain Table 

Domain Explorer 

Add Proxy Servers 

Manually Deploy Guardian Agent 
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Inventory Domain
To Inventory a Domain means to create a new Domain Inventory. The Domain Inventory 
provides a snapshot of your domain and can be reviewed and printed with the Domain Inventory 
editor. Although Domain Inventories are created automatically when activating and evaluating 
domains, sometimes people find it helpful to inventory a domain just to check its status, or print 
a description of it.

You use the Inventory Wizard to inventory a domain. There are several different ways to invoke 
the Inventory Wizard:

Press Ctrl+Shift+I. 

Click the Inventory button on the Main Toolbar. 

Select New > Inventory from the File menu. 

Right-click inside the Domain Explorer and select Inventory from the pop-up context 
menu. 

The Inventory Wizard allows you to select the domain to inventory. If a domain is selected and 
the Domain Explorer or Active Domain Table is active when the Inventory Wizard is invoked, it 
will assume that is the domain you want to inventory.

If you selected the option to remember the username and password when activating or modifying 
the target domain, the Inventory Wizard will open with the username and password will already 
be filled in. Otherwise, you have to enter the username and password of an administrator account 
on the domain. You can select whether to remember the username and password for future 
domain operations.

When the inventory is created, you can view the results in the Domain Inventory editor.

Related Concepts
Domain Inventory 

Evaluation 

Related Tasks
Activate Domain 

Evaluate Domain 



Act iva te  Domain

BEA Guardian User Guide 3-13

Related Reference
Domain Inventory 

Domain Explorer 

Domain Activation Wizard 

Domain Properties 

Keyboard Shortcuts 

Main Toolbar 

Main Menu 
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Create Shortcut
A shortcut allows you to preselect a domain and signature bundle to save steps in conducting 
evaluations. There are several different ways to invoke the Shortcut Wizard to create a shortcut:

Press Ctrl+Shift+S. 

Select New > Shortcut from the File menu. 

Click the Add Shortcut button in the Shortcut Table toolbar. 

Right-click inside the Shortcut Explorer and select Add Shortcut from the pop-up context 
menu. 

The Shortcut Wizard allows you to select a target domain, a signature bundle, and a shortcut 
name.

You can also create a shortcut by selecting the Save as Shortcut option in the Evaluation Wizard.

Once you create a shortcut, there are several different ways to invoke it:

Double-click it in the Shortcut Table. 

Double-click it in the Shortcut Explorer. 

Right-click it in the Shortcut Explorer and select Evaluate from the pop-up context menu. 

When you invoke the shortcut, it opens the Shortcut Evaluation Wizard with the domain and 
bundle already selected.

Related Concepts
Shortcut 

Domain 

Bundle 

Evaluation 

Signature 

Related Tasks
Delete Shortcut 
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Related Reference
Shortcut Wizard 

Shortcut Table 

Shortcut Explorer 

Shortcut Evaluation Wizard 

Keyboard Shortcuts 

Main Toolbar 

Main Menu 
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Evaluate Shortcut
To identify potential problems before they occur with less effort, you evaluate shortcuts with the 
Shortcut Evaluation Wizard. You can invoke the Shortcut Evaluation Wizard in any of the 
following ways:

Double-click a shortcut in the Shortcut Table. 

Double-click a shortcut in the Shortcut Explorer. 

Right-click a shortcut in the Shortcut Explorer and select Evaluate Shortcut from the 
pop-up context menu. 

The Shortcut Evaluation Wizard opens with the domain and bundle specified in the shortcut 
preselected. You can change the bundle. If you selected the remember username/password option 
when activating or modifying the target domain, the username and password will already be filled 
in. Otherwise, you must enter them before launching the evaluation.

When the evaluation is complete, you can view the results in the Evaluation Summary.

Related Concepts
Shortcut 

Domain 

Bundle 

Evaluation 

Related Tasks
Activate Domain 

Modify Domain 

Related Reference
Shortcut Evaluation Wizard 

Shortcut Table

Shortcut Explorer

Evaluation Summary 
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Delete Shortcut
A shortcut allows you to preselect a domain and signature bundle to save steps in conducting 
evaluations. There are two different ways to delete a shortcut:

Select a shortcut from the Shortcut Table and click the Delete Shortcut button on the 
toolbar. Please note that the Delete Shortcut button will be grayed out and cannot be 
clicked until a shortcut has been selected. 

Right-click a shortcut in the Shortcut Explorer and select Delete Shortcut from the pop-up 
context menu. 

Related Concepts
Shortcut 

Domain 

Bundle 

Evaluation 

Related Tasks
Create Shortcut 

Related Reference
Shortcut Table 

Shortcut Explorer 
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Update Guardian
To Update Guardian, use the Update Wizard to download new BEA Guardian software and 
signatures from the BEA Guardian update site, http://guardian.bea.com/update.

There are several different ways to invoke the Update Wizard:

Press Ctrl+Shift+U. 

Click the Update button on the Main Toolbar. 

Select Software Updates > Guardian Updates from the Help Menu. 

The Update Wizard takes you through a sequence of steps to access the Guardian update site, 
select the available signature and application feature updates, download them, and install them 
onto your version of Guardian. The following list briefly describes each step. See the Update 
Wizard description for more details:

Enter your BEA eSupport login username and password to access your eSupport site 
identifiers. 

Select your eSupport site identifier. 

Enter your BEA eSupport login username and password again to access the Guardian 
update site. 

Select the available features to install. 

Accept the terms in the license agreement. 

Accept the installation location. 

Verify the list of features to install. 

Restart Guardian to incorporate the new features. 

Related Concepts
Signature 

Related Reference
Update Wizard 

Keyboard Shortcuts 
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Main Toolbar 

Main Menu 
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Uninstall Guardian
To Uninstall Guardian, simply delete the folder you specified when you installed Guardian.

Please note that due to the restriction that you cannot specify a Guardian Workspace location in 
the Guardian installation directory, your Guardian Workspace will have to be deleted separately 
(at the location you specified when you started Guardian). The Guardian Workspace contains 
Domain Inventories and Evaluation Summaries for each domain you activate and evaluate. This 
restriction is to preserve the implicit contract with the customer that their data will never be 
removed, even during uninstallation.

Related Concepts
Guardian Workspace 

Domain Inventory 

Domain 

Related Tasks
Activate Domain 

Evaluate Domain 

Related Reference
Evaluation Summary

Related Getting Started
Installation 

Starting the Graphical User Interface
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Reference

Main Menu
The BEA Guardian Main Menu is located below the Main Title Bar and above the Main Toolbar. 
Running from left to right, the Main Menu headings are:

Figure 4-1  Main Menu Headings

File 

Tools 

Window 

Help 

File Menu
The menu options in the File menu are:
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Figure 4-2  Main Menu File Menu

New - Opens a submenu with: 

– Domain - Invokes the Domain Activation Wizard. 

– Inventory - Invokes the Inventory Wizard. 

– Evaluation - Invokes the Evaluation Wizard. 

– Shortcut - Invokes the Shortcut Wizard. 

Close - Closes the most recently opened or most recently active editor in the Document 
Pane. 

Close All - Closes all the open editors in the Document Pane. 

Print - Prints the contents of the Report tab for whichever one of these editors is active in 
the Document Pane: 

– Domain Inventory 

– Evaluation Summary 

– Signature Details 

– Bundle Details 

Import - Reserved for future use. 

Export - Reserved for future use. 
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Exit - Closes the Guardian application. 

Tools Menu
The menu options in the Tools menu are:

Figure 4-3  Main Menu Tools Menu

Refresh Site List - Updates the list of BEA Support site identifiers available for creating 
support cases. 

Purge Inactive Domains - Removes domains that have been deactivated from the Domain 
Explorer and the Guardian Registry. Each purged domain's Domain Inventories, Evaluation 
Summaries, and Case Creation Archives are deleted from the Guardian Workspace on disk. 

View Log - Opens the Guardian Log file and the Signature Log file. 

Window Menu
The menu options in the Window menu are:
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Figure 4-4  Main Menu Window Menu

Show View - Opens a submenu with the following choices to open certain views. Please 
note that if a view is already open it is brought to the forefront and made active rather than 
cloned: 

– Domain Explorer - Opens the Domain Explorer view in the Navigation Pane. 

– Bundle Explorer - Opens the Bundle Explorer view in the Navigation Pane. 

– Shortcut Explorer - Opens the Shortcut Explorer view in the Navigation Pane. 

– Signature Explorer - Opens the Signature Explorer view in the Navigation Pane. 

– Active Domain Table - Opens the Active Domain Table view in the Document Pane. 

– Shortcut Table - Opens the Shortcut Table view in the Document Pane. 

– Progress View - Opens the Progress View to the left of the Document Pane. 

– Outline View - Opens the Outline View to the right of the Document Pane. 

Reset Perspective - Resets the Guardian application window settings to their original 
values. This includes opening and arranging all of the Navigator views, opening the 
Outline and Progress views, and resizing the Document Pane. Any open views and editors 
remain open. 

Preferences - Opens the Preferences page. 
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Help Menu
The menu options in the Help menu are:

Figure 4-5  Main Menu Help Menu

Welcome - Opens the Guardian Welcome Page. 

Help Contents - Opens the Guardian help system, which includes the Guardian User Guide, 
a guide to using the Guardian help, and a utility for searching help. 

Search - Opens a utility that searches the Guardian User Guide for the text you enter. 

Dynamic Help - Opens the Guardian dynamic help system. Dynamic help displays all the 
help text from the Guardian User Guide relating to the currently active view or editor. The 
dynamic help automatically updates itself to match each view or editor you select. 

Tips and Tricks - Opens a dialog box to select a Guardian Tips and Tricks table. The Tips 
and Tricks table describes how to perform certain Guardian tasks more efficiently. 

Cheat Sheet - Opens a dialog box to select a Guardian Cheat Sheet. The Cheat Sheet shows 
how to perform certain Guardian tasks, step by step. Some of the steps can be done for you 
automatically at the press of a button. 

Manage Guardian - opens a submenu with: 

– Update Guardian - Invokes the Update Wizard. 

– Manage Configuration - Opens the Product Configuration Manager which allows you 
to perform the following tasks: 
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• Scan for Updates - Invokes the Update Wizard. 

• View Installation History - Shows what application updates you have installed since 
first installing Guardian. 

• Show Activities - Shows the steps that led to the current Guardian configuration.

• Add an Extension Location - Allows you to extend Guardian.

Key Assist - Opens a window that lists all the Guardian Keyboard Shortcuts. 

About BEA Guardian - Opens the About BEA Guardian dialog box which provides the 
specific Guardian version and details on the Guardian features, plug-ins, and configuration. 

Related Concepts
Support Case 

Domain 

Guardian Registry 

Guardian Workspace 

Related Tasks
Deactivate Domain 

Submit Support Case 

Related Reference
Domain Activation Wizard 

Evaluation Wizard 

Shortcut Wizard 

Document Pane 

Domain Inventory 

Evaluation Summary 

Signature Details 

Bundle Details 
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Navigation Pane 

Domain Explorer 

Bundle Explorer 

Shortcut Explorer 

Signature Explorer 

Active Domain Table 

Shortcut Table 

Keyboard Shortcuts 

Related Getting Started
Interacting with the Graphical User Interface 

Starting the Graphical User Interface 
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Main Toolbar
The BEA Guardian Main Toolbar is located below the Main Title Bar and Main Menu and above 
the Navigation Pane. Running from left to right, the Main Toolbar buttons are:

Figure 4-6  Main Toolbar

Open - Opens the selected resource for editing or execution: 

– Active Domain Table when Target Domains is selected in the Domain Explorer 

– Domain Inventory when a Domain Inventory is selected in the Domain Explorer 

– Evaluation Summary when an Evaluation Summary is selected in the Domain Explorer 

– Signature Details when a signature is selected in the Signature Explorer and Bundle 
Explorer 

– Bundle Details when a bundle is selected in the Bundle Explorer 

– Evaluation Wizard when a shortcut is selected in the Shortcut Explorer. 

Print - Prints the contents of the Report tab for whichever one of these editors is active in 
the Document Pane: 

– Domain Inventory 

– Evaluation Summary 

– Signature Details 

– Bundle Details 

Activate - Invokes the Domain Activation Wizard. 

Inventory - Invokes the Inventory Wizard. 

Evaluate - Invokes the Evaluation Wizard. 

Update - Invokes the Update Wizard. 

When the mouse pointer is over a toolbar button, a tool tip window pops up under the 
mouse pointer that says what the button does.
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Figure 4-7  Main Toolbar with Tool Tip

Related Concepts
Shortcut 

Related Reference
Navigation Pane 

Document Pane 

Active Domain Table 

Domain Explorer 

Domain Inventory 

Evaluation Summary 

Signature Details 

Signature Explorer 

Bundle Explorer 

Bundle Details 

Shortcut Explorer 

Domain Activation Wizard 

Inventory Wizard 

Evaluation Wizard 

Update Wizard 

Related Getting Started
Interacting with the Graphical User Interface 
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Keyboard Shortcuts
The Keyboard Shortcuts are sequences of keystrokes that allow you to perform certain Guardian 
graphical user interface operations without using the mouse pointer.

The following table lists the Guardian Keyboard Shortcuts and can be displayed by pressing 
Ctrl+Shift+L:

Figure 4-8  Keyboard Shortcuts

Related Reference
Main Menu 

Main Toolbar 

Related Getting Started
Interacting with the Graphical User Interface 
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Navigation Pane
The Navigation Pane contains these views, by default on the left hand side of the BEA Guardian 
window:

Domain Explorer 

Bundle Explorer

Signature Explorer 

Shortcut Explorer 
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Figure 4-9  Navigation Pane Example

Related Reference
Domain Explorer 

Bundle Explorer 
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Signature Explorer 

Shortcut Explorer 
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Domain Explorer

Overview
The Domain Explorer is a Navigator view that allows you to browse and interact with the 
domains that you have activated.

Figure 4-10  Domain Explorer Overview

Domain Nodes
The first time you activate a domain, a domain node is added to the Target Domains folder. To 
distinguish between domains that could have the same name, the domain node name is a 
generated name. The generated name includes the host name and listen port you entered in the 
Domain Activation Wizard. The domain node name is also known as the domainId in the 
Guardian Command Line Interface.
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The format of the generated domain name is: <domain name>_<host name>_<listen 
port>. For example, guardian-test_mj23_32292, would be the domain node name for a domain 
named "guardian-test" activated with a host name, "mj23", and a listen port, "32292".

The Domain Explorer includes both active and inactive domain nodes. Active domain nodes are 
listed in bold. Inactive domain nodes are not bold. Inactive domain nodes can be removed with 
the Purge Inactive Domains option in the Tools menu.

Figure 4-11  Domain Explorer Active and Inactive Domains

Domain nodes also include icons. As indicated below, one icon is for active domains and one is 
for inactive domains. Active domains can also be decorated with icons that indicate whether the 
username and password have been persisted, and whether the domain requires SSL encryption 
for all communication. Please note that Guardian uses 128 bit open source encryption for SSL.

The following graphic and table shows five domains with their icons:

Icon Meaning

Domain is active.

Domain is inactive.

Username and password have been persisted (icon decorates active domain 
icon).

Domain requires 128 bit SSL (icon decorates active domain icon).



Refe rence

4-16 BEA Guardian User Guide

Figure 4-12  Domain Explorer Icons

Domain History Folders
Each domain node contains folders that accumulate all your Domain Inventories and Evaluation 
Summaries. These folders are persisted on disk in the Guardian Workspace.

Figure 4-13  Domain Explorer History Folders

Domain Name Active/ 
Inactive

Password Persisted/ Not 
Persisted

128 bit SSL 
Enabled/ Not 
Enabled

816clusterdomain Inactive N/A N/A

guardian-dev Active Not Persisted Not Enabled

mydomain Active Persisted Not Enabled 

QA_815_windows Active Not Persisted Enabled

WLS92cluster Active Persisted Enabled
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Inventory History Folder
Every time you activate, evaluate, or inventory a domain, a new Domain Inventory is created and 
added to the domain's Inventory History folder. If you double-click a Domain Inventory, a 
Domain Inventory editor opens in the Document Pane.

To distinguish between Domain Inventories, the Domain Inventory name is a generated name. To 
enforce uniqueness, the generated name includes the domain name, host name, listen port, date 
and time it was created, in the format: <domain name>_<host name>_<listen 
port>_<date> <time>.

Figure 4-14  Domain Explorer Inventory History

Evaluation History Folder
Every time you evaluate a domain, a new Evaluation Summary is created and added to the 
domain's Evaluation History folder. If you double-click an Evaluation Summary, an Evaluation 
Summary editor opens in the Document Pane.

To distinguish between Evaluation Summaries, the Evaluation Summary name is a generated 
name. To enforce uniqueness, the generated name includes the bundle evaluated, date and time it 
was created, in the format: <bundle name>_<date> <time>.
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Figure 4-15  Domain Explorer Evaluation History

The Evaluation Summary entry includes an icon that indicates whether any signatures were 
detected. If any signatures were detected, the icon is decorated with a severity indicator. The icon 
with its severity indicator identifies the most severe signature detected:

Context Menu
The Domain Explorer has a context menu. To open it, right-click inside the Domain Explorer. 
The menu that pops up includes these choices:

Delete 

Activate 

Deactivate 

Icon Severity Meaning

Critical The evaluation detected at least one critical signature.

Warning The evaluation detected at least one warning signature and 
no critical signatures.

Informational The evaluation detected at least one informational 
signature and no critical or warning signatures.

No Signature The evaluation did not detect any signatures.
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Modify Domain 

Inventory 

Add Shortcut 

Evaluate 

Evaluate Bundle 

Please note that if you right-click any entry in an expanded, active domain node, or any entry in 
an active domain node is selected when you right-click, the Inventory, Add Shortcut, Evaluate, 
and Evaluate Bundle menu options will proceed as if that is the domain you want to target. Also, 
the Deactivate and Modify Domain menu options are unavailable unless you right-click directly 
on an active domain node, or an active domain node is selected when you right-click. Conversely, 
the Activate menu option is unavailable if an active domain node is selected.

The Delete menu option deletes the Domain Inventories and Evaluation Summaries that are 
selected in the Domain Explorer. It deletes the entries from the Domain Explorer as well as the 
underlying files from the Guardian Workspace. A confirmation box allows you to cancel the 
deletion. You can also use the Delete key on your keyboard to delete any selected Domain 
Inventories and Evaluation Summaries.

The Evaluate Bundle menu option opens a submenu that lists all the bundles available for 
evaluation. Selecting any of them invokes the Bundle Evaluation Wizard. The Bundle Evaluation 
Wizard opens with the currently selected domain and the bundle you select, just as if you had 
invoked a shortcut. The Bundle Evaluation Wizard works just like the Shortcut Evaluation 
Wizard. Unless an active domain node or one of its entries is selected, or you right-click an active 
domain node or one of its entries, the bundle list is greyed out and can't be selected.

Title Bar
The Domain Explorer title bar contains these icons you can click:

Icon Name

Close

Minimize
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Filter Domain Explorer
Clicking the Domain Explorer's Menu icon and selecting the Filter Domain Explorer menu option 
opens the Filter Domain Explorer dialog box which allows you to filter out the older Domain 
Inventories and Evaluation Summaries.

Maximize

Restore

Expand all items

Collapse all items

Menu

Link with Editor
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Figure 4-16  Domain Explorer Filter Domain Explorer Before

Figure 4-17  Domain Explorer Filter Domain Explorer Dialog Box
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Figure 4-18  Domain Explorer Filter Domain Explorer After

Related Concepts
Domain 

Domain Inventory 

Guardian Workspace

Bundle 

Shortcut 

Related Tasks
Activate Domain 

Deactivate Domain 
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Inventory Domain 

Modify Domain 

Create Shortcut

Related Reference
Evaluation Summary 

Domain Activation Wizard 

Domain Inventory 

Document Pane 

Shortcut Evaluation Wizard 

Main Menu 

Related Getting Started
Starting and Using the Command Line Interface 
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Signature Explorer
The Signature Explorer is a Navigator view that allows you to browse and interact with the 
available signatures.

Figure 4-19  Signature Explorer List Signatures

The signature entries include the following severity indicator icons. The severity indicator 
approximates the level of attention you should give the signature when it is detected.

If you double-click a signature in the Signature Explorer, a Signature Details editor opens in the 
Document Pane.

The Signature Explorer title bar contains these icons you can click:

Icon Severity

Critical

Warning

Informational
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Clicking the Signature Explorer's Menu icon opens a menu that allows you to sort and filter the 
list of signatures displayed:

Figure 4-20  Signature Explorer Menu

The Sort Signatures submenu offers you these choices: 

– By Name - lists the signatures alphabetically by name. This is the default ordering 
when you first open the Signature Explorer. 

Icon Name

Close

Minimize

Maximize

Restore

Menu
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Figure 4-21  Signature Explorer Sort Alphabetically

– By Severity - groups the signatures by severity level, and then lists the signatures 
alphabetically by name within each severity level. 

Figure 4-22  Signature Explorer Sort by Severity

The Filters menu option opens the Signature Filters dialog box which allows you to specify 
which signatures you want to see listed in the Signature Explorer. 
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Figure 4-23  Signature Explorer Signature Filters

Related Concepts
Signature 

Evaluation 

Related Reference
Signature Details 

Document Pane 

Signature Filters 
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Signature Filters
Signature Filters is a dialog box that allows you to specify which signatures the Signature 
Explorer displays.

Figure 4-24  Signature Filters Dialog Box

To open the Signature Filters dialog box, click the Menu icon in the Signature Explorer and select 
the Filters menu option.

The Signature Filters dialog box contains the following components that determine which 
signatures are displayed:

Name Filter Pattern - a text box that allows you to enter a search pattern for the signature 
names you want to select. For example: 

– SSL* selects all signatures whose first three letters are SSL Please note that Guardian 
uses 128 bit open source encryption for SSL.

– *8.?* selects all the signatures relating to WebLogic Server Version 8 
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Figure 4-25  Signature Filters Name Filter Pattern

Whether the names you select are displayed or filtered out depends on the following radio 
button settings. 

Show matching names - a radio button that causes the signatures matching the Name Filter 
Pattern text box to be displayed rather than filtered out. 
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Figure 4-26  Signature Filters Show Matching Names

Hide matching names - a radio button that causes the signatures matching the Name Filter 
Pattern text box to be filtered out rather than displayed. 

Figure 4-27  Signature Filters Hide Matching Names
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Select the severity levels to include - a check box for each severity level: Critical, Warning, 
or Informational that further refines which signatures are displayed. Whatever the results 
are of the Name Filter Pattern text box and the Show matching names and Hide matching 
names radio buttons, only the signatures matching the severity levels selected in these 
check boxes are displayed. 

Figure 4-28  Signature Filters Select Severity Level

Related Concepts
Signature 

Related Reference
Signature Explorer 
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Bundle Explorer
The Bundle Explorer is a Navigator view that allows you to browse and interact with the available 
bundles of signatures.

The Bundle Explorer contains a top level folder called Bundles. In the Bundles folder is a node 
for each bundle that's available for evaluation. Each bundle node contains all the bundle's 
signatures.

Figure 4-29  Bundle Explorer List of Bundles

Signatures are grouped into different bundles based on their characteristics. For example, the 
Security Advisories bundle contains signatures that detect potential security problems for which 
BEA has issued security advisories. The Service Pack Remedy bundle contains signatures whose 
resolution requires installation of a specific service pack. The Bundle Details editor describes 
each of the Guardian signature bundles.

The signature entries in each bundle node include the following severity indicator icons. The 
severity indicator approximates the level of attention you should give the signature when it is 
detected.

Icon Severity

Critical
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If you double-click a bundle in the Bundle Explorer, a Bundle Details editor opens in the 
Document Pane.

Similarly, if you double-click a signature in the Bundle Explorer, a Signature Details editor opens 
in the Document Pane.

The Bundle Explorer title bar contains these icons you can click:

Clicking the Bundle Explorer's Menu icon opens a menu that allows you to sort the signatures 
displayed in each bundle. From the Sort Signatures submenu, you can select:

Warning

Informational

Icon Name

Close

Minimize

Maximize

Restore

Expand all items

Collapse all items

Menu
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Figure 4-30  Bundle Explorer Sort Menu

By Bundle Name, Signature Name - lists the signatures in each bundle alphabetically by 
name. This is the default ordering when you first open the Bundle Explorer. 

Figure 4-31  Bundle Explorer List Alphabetically

By Bundle Name, Severity - groups the signatures in each bundle by severity level, and 
then lists the signatures alphabetically by name within each severity level. 
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Figure 4-32  Bundle Explorer List By severity

Please note that selecting either of the Sort Signatures choices collapses all the bundle nodes. To 
see the signatures in their new sort order, either click each bundle node individually to expand it, 
or click the Expand all items icon to expand all the bundle nodes.

Related Concepts
Bundle 

Signature 

Evaluation 

Related Reference
Bundle Details 

Document Pane 

Signature Details 
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Shortcut Explorer
The Shortcut Explorer is a view in the Navigation Pane that allows you to manage the shortcuts 
you have created.

Figure 4-33  Shortcut Explorer List Shortcuts

If you double-click a shortcut in the Shortcut Explorer, the Shortcut Evaluation Wizard opens 
with the shortcut's target domain and signature bundle preselected. Shortcuts save steps by saving 
the domain and bundle so you don't have to select them each time you perform an evaluation.

Figure 4-34  Shortcut Explorer Shortcut Evaluation Wizard
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The Shortcut Explorer has a context menu. To open it, right-click inside the Shortcut Explorer. 
The menu that pops up contains the following options:

Add Shortcut 

Delete Shortcut 

Evaluate Shortcut 

Please note that if you right-click a shortcut, or a shortcut is selected when you right-click, the 
Delete Shortcut and Evaluate Shortcut menu options will proceed as if that is the shortcut you 
want to delete or evaluate. Conversely, the Delete Shortcut and Evaluate Shortcut menu options 
are unavailable unless you right-click directly on a shortcut, or a shortcut is selected when you 
right-click.

The Shortcut Explorer title bar contains these icons you can click:

Related Concepts
Shortcut 

Domain 

Bundle 

Evaluation 

Icon Name

Close

Minimize

Maximize

Restore
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Related Tasks
Create Shortcut 

Delete Shortcut 

Evaluate Shortcut 

Related Reference
Navigation Pane 

Shortcut Evaluation Wizard 
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Document Pane
The Document Pane is the location where these BEA Guardian views and editors open, by default 
in the central region of the BEA Guardian window:

Active Domain Table 

Domain Inventory 

Evaluation Summary 

Signature Details 

Bundle Details 

Shortcut Table 

Figure 4-35  Document Pane Example

Related Reference
Active Domain Table 
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Domain Inventory 

Evaluation Summary 

Signature Details 

Bundle Details 

Shortcut Table 
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Active Domain Table
The Active Domain Table is a view in the Document Pane that allows you to manage the domains 
you've activated.

Figure 4-36  Active Domain Table Sorted by Domain Name

To open the Active Domain Table, select Show View > Active Domain Table from the BEA 
Guardian Window Menu.

The Active Domain Table lists the active domains, each having these columns:

Figure 4-37  Active Domain Table Column Headings

Domain: the domain name 

Administration Server URL: the URL of the domain's Administration Server 

Last Evaluation: the name of the Evaluation Summary for the most recent evaluation 
performed. 

By default, the domains are listed alphabetically by domain name. Clicking a column heading 
sorts the domains by that column. For example, clicking the Last Evaluation column sorts the 
domains alphabetically by the last evaluation's Evaluation Summary name. Clicking the same 
column heading in succession alternates between sorting in alphabetical order and reverse 
alphabetical order.
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Figure 4-38  Active Domain Table Sorted by Last Evaluation in Reverse Order

The Active Domain Table toolbar contains the following buttons. Please note that they can't be 
clicked until you select one of the active domains listed:

Figure 4-39  Active Domain Table Toolbar Buttons

Open Admin Console - opens a BEA Weblogic Server Administration Console in your 
Web browser. The Administration Console is a Web application that is hosted by the 
Administration Server which you specified in the Domain Activation Wizard. 

Figure 4-40  Active Domain Table Administration Server Console Login

If you selected the Remember username/password check box when activating or modifying 
the domain, the browser will automatically log you into the Administration Console. If not, 
the browser will start at the Administration Console login page.

Figure 4-41  Active Domain Table Remember Username and Password Check Box

Administration Console documentation can be found on the BEA eDocs website for:
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– BEA WebLogic Server 9.1 

– BEA WebLogic Server 8.1 

Modify Domain - opens the Domain Properties dialog box, which allows you to change 
how Guardian accesses the domain. 

Deactivate Domain - invokes the Domain Deactivation Wizard to deactivate the domain. 

Related Concepts
Domain 

Related Tasks
Activate Domain 

Modify Domain 

Related Reference
Document Pane 

Evaluation Summary 

Domain Activation Wizard 

Domain Properties 

Domain Deactivation Wizard 

Main Menu 
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Domain Properties
The Domain Properties dialog box allows you to modify how BEA Guardian accesses a target 
domain. In particular, you can change:

The username and password Guardian uses to access the domain 

Whether to remember the username and password 

Whether to use a proxy server to access the domain 

There are two different ways to open the Domain Properties dialog box:

Select a domain in the Active Domain Table and click the Modify Domain button. 

Right-click a domain in the Domain Explorer and select Modify Domain. 

Figure 4-42  Domain Properties Dialog Box

The Domain Properties dialog box includes the following components:

The domain name, read only 
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The URL of the domain's Administration Server, read only 

The username and password of an administrator account on the domain 

Please note that changing the username and password in Guardian does not change the 
username and password on the domain.

Whether to remember the username and password 

If selected, the username and password are encrypted and stored on disk. Then, whenever 
you evaluate, inventory, modify, or open an admin console to the domain, or submit a 
support case, the domain's username and password are filled in automatically. Otherwise, 
you have to enter them for each operation that accesses the domain.

Whether to use a proxy server to access the domain 

If selected, you must select the name of the proxy server from the drop down list. If there 
are no proxy servers in the drop down list, the Enable proxy connection check box is 
disabled. To add a proxy server, select Proxy from the Preferences page. Please note that in 
order to use a proxy server, you must also manually deploy the Guardian Agent onto the 
target domain.

Related Concepts
Domain 

Security & Privacy 

Related Tasks
Evaluate Domain 

Inventory Domain 

Modify Domain 

Submit Support Case 

Related Reference
Active Domain Table 

Domain Explorer 

Preferences 
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Domain Inventory
A Domain Inventory is an XML document, persisted in the Guardian Workspace, that describes 
the products in your domain. The Domain Inventory editor in the Document Pane allows you to 
interact with the Domain Inventory to better understand how BEA Guardian evaluates your 
domain.

Figure 4-43  Domain Inventory Overview Tab

A Domain Inventory is created when you activate a domain and a new one is created each time 
you evaluate a domain. You can also create a new Domain Inventory with the Inventory Wizard. 
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The Inventory History folder in the Domain Explorer contains all the Domain Inventories for a 
domain.

You can open a Domain Inventory editor in any of the following ways:

Activate a domain, or inventory a domain. Then click the OK button in the Progress View. 

Figure 4-44  Domain Inventory from Progress View

Double-click a Domain Inventory in the Inventory History folder of a domain in the 
Domain Explorer. 

Figure 4-45  Domain Inventory from Domain Explorer

On the bottom of the Domain Inventory editor are the following tabs for the different Domain 
Inventory representations. Please note that these representations are read only:

Overview - provides a summary of the Domain Inventory. It contains the following 
sections: 
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Figure 4-46  Domain Inventory Overview Tab

– General Information - the domain name and date and time the Domain Inventory was 
created. 

– Servers - the number of servers in the domain, the number of servers active at the time 
of the inventory, a list of the servers, and information about each server. Please note 
that if a server is down at the time of an evaluation, it could mask some signatures from 
being detected. 

When you click on a server in the list, the following server information is displayed. 
Information on the first server in the list is displayed by default:
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• Server Details - the server's name and WebLogic version, whether the server is the 
Administration Server or not, and whether the server is in production mode or not. 

• Java Details - the Java vendor and version, and the Java Virtual Machine vendor, 
name, and version. 

• Operating System Details - the operating system name, version, and processor 
architecture. 

– JDBC - the number of JDBC connection pools, a list of the JDBC connection pools, 
and details about each JDBC connection pool. 

When you click on a JDBC connection pool in the list, the following JDBC connection 
pool details are displayed. JDBC connection pool details on the first JDBC connection 
pool in the list are displayed by default:

• the JDBC connection pool name 

• the JDBC data source name 

• the database product name and version 

• the JDBC driver name and version 

Source - provides the actual XML source for the Domain Inventory. It can be copied to 
your paste buffer or printed with the context menu. You can access the context menu by 
right-clicking inside the Domain Inventory. 
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Figure 4-47  Domain Inventory Source Tab

Report - provides all the information contained in the Overview tab in a printer friendly 
format. It can also be copied into your paste buffer or printed with the context menu. 
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Figure 4-48  Domain Inventory Report Tab

When the Outline View is open and the Domain Inventory editor is active, you can use the 
Outline View to control what the Domain Inventory editor displays. Clicking the Overview, 
Source, and Report nodes in the Outline View brings the corresponding tab of the Domain 
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Inventory editor to the forefront. Expanding the Outline View's Source node allows you to select 
specific XML tag names, causing the Domain Inventory editor to jump to those tags and 
hightlight them.

Figure 4-49  Domain Inventory Outline View
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Related Concepts
Domain Inventory 

Guardian Workspace 

Domain 

Evaluation 

Signature 

Related Tasks
Activate Domain 

Evaluate Domain 

Inventory Domain

Related Reference
Document Pane 

Inventory Wizard 

Domain Explorer 
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Evaluation Summary
An Evaluation Summary is created each time you evaluate a domain, and is persisted in the 
Guardian Workspace. The Evaluation Summary editor in the Document Pane allows you to 
interact with the Evaluation Summary and determine if you need to take any corrective action.

These are the different ways to open an Evaluation Summary:

Conduct an evaluation. An Evaluation Summary is opened automatically when the 
evaluation completes. 

Double-click an Evaluation Summary entry in the Evaluation History folder of the Domain 
Explorer. 

Figure 4-50  Evaluation Summary from Domain Explorer

On the bottom of the Evaluation Summary editor are the following tabs for the different 
Evaluation Summary representations. Please note that these representations are read only:

Overview - provides evaluation statistics and a list of detected signatures. It also includes a 
description and remedy recommendation for each signature detected in the evaluation. It 
contains the following sections. Each section can be expanded or collapsed by clicking the 
triangle icon in the heading. 
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Figure 4-51  Evaluation Summary Overview Tab

– General Information - the target domain name, the signature bundle evaluated, the date 
and time of the evaluation, the length of time to conduct the evaluation, and the number 
of signatures targeted, detected, not detected, and undetectable in the evaluation. 

For a given bundle of signatures, some signatures may not be used in the evaluation 
because they target different products than the domain has. The ones that do target what 
the domain has are counted as Targeted Signatures. The Targeted Signatures are divided 
into Detected Signatures, which are actually found on the domain; and Undetected 
Signatures, which are not found on the domain. If a signature fails to evaluate, it is 
counted as an Undetectable Signature, and is considered flawed.

– Detected Signatures - a table that includes information about every signature detected 
in the evaluation, including the signature name, identification number, severity, area of 
impact, and BEA product affected. It also includes the signature topic and subtopic, 
which further narrow the category of potential problem found. If you submitted any 
support cases to BEA, the case information is listed as well. 

Clicking a detected signature displays information about it in the Description and 
Remedy sections. Information about the first detected signature is displayed by default. 
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You can sort the detected signature table by clicking any of the column headings. The 
detected signatures are sorted by severity and name by default.

The Severity column of the detected signature table includes an icon that approximates 
the amount of attention you should give each signature that has been detected.

– Description - information about the signature, from the signature XML file itself. 
Description includes the signature name, severity, category of impact (for example, 
Server Outage, Performance, or User Viewable Error), and a detailed description. 

– Remedy - an explanation of how to resolve the potential problem, from the signature 
XML file itself. It includes the servers impacted by the signature and links to get more 
information about the potential problem. 

Remedy also includes a link, Get more help from BEA Support, which opens the 
Support Case Wizard. Opening a support case allows you to get more help from BEA 
to analyze and repair the potential problem that the signature detected.

Source - provides the actual XML source from the Evaluation Summary. It includes the 
raw data for each detected and undetected signature, and can be copied to your paste buffer 
or printed with the context menu. You can access the context menu by right-clicking inside 
the Evaluation Summary. 

Icon Severity

Critical

Warning

Informational
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Figure 4-52  Evaluation Summary Source Tab

Report - provides all the information contained in the Overview tab in a printer friendly 
format. It can also be copied into your paste buffer or printed with the context menu. 
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Figure 4-53  Evaluation Summary Report Tab

When the Outline View is open and the Evaluation Summary editor is active, you can use the 
Outline View to control what the Evaluation Summary editor displays. Clicking the Overview, 
Source, and Report nodes in the Outline View brings the corresponding tab of the Evaluation 
Summary editor to the forefront. Expanding the Outline View's Source node allows you to select 
specific XML tag names, causing the Evaluation Summary editor to jump to those tags and 
highlight them.
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Figure 4-54  Evaluation Summary Outline View

Related Concepts
Evaluation 

Domain 

Guardian Workspace 
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Bundle 
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Support Case 

Related Tasks
Evaluate Domain 

Related Reference
Document Pane 

Domain Explorer 
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Signature Details
A signature is an XML document that identifies potential problems in your domain. The 
Signature Details editor in the Document Pane provides more information about each signature.

Figure 4-55  Signature Details Overview Tab

To open a Signature Details editor, double-click a signature in the Signature Explorer or Bundle 
Explorer.
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Figure 4-56  Signature Explorer

On the bottom of the Signature Details editor are the following tabs for the different Signature 
Details representations. Please note that these representations are read only:

Overview - provides information about the signature and how it was created. It contains 
these sections: 
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Figure 4-57  Signature Details Overview Tab

– General Information - the signature identifier, name, publication date, and severity level 
(Critical, Warning, or Informational). 

– Description - an explanation of the signature in plain language, from the actual 
signature XML file itself. 

– Target - the XPath expression used to match the signature with the target domain's 
Domain Inventory. 

Source - provides the actual XML source for the signature. It includes the raw data for 
each signature, and can be copied to your paste buffer or printed with the context menu. 
You can access the context menu by right-clicking inside the Signature Details editor. 
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Figure 4-58  Signature Details Source Tab

Report - provides all the information contained in the Overview tab in a printer friendly 
format. It can also be copied into your paste buffer or printed with the context menu. 
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Figure 4-59  Signature Details Report Tab

When the Outline View is open and the Signature Details editor is active, you can use the Outline 
View to control what the Signature Details editor displays. Clicking the Overview, Source, and 
Report nodes in the Outline View brings the corresponding tabs of the Signature Details editor to 
the forefront. Expanding the Outline View's Source node allows you to select specific XML tag 
names, causing the Signature Details editor to jump to those tags and hightlight them.
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Figure 4-60  Signature Details Outline View

Related Concepts
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Bundle Details
A bundle is a group of signatures that are evaluated together. The Bundle Details editor in the 
Document Pane provides more information about each bundle.

Figure 4-61  Bundle Details Overview Tab

To open a Bundle Details editor, double-click a bundle node in the Bundle Explorer.

Figure 4-62  Bundle Explorer
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On the bottom of the Bundle Details editor are the following tabs for the different Bundle Details 
representations. Please note that these representations are read only:

Overview - provides information about the bundle and how it was created. It contains the 
following sections: 

Figure 4-63  Bundle Details Overview Tab

– General Information - the bundle identifier, name, creation date, and modification date. 

– Description - a plain language description of the bundle. 

– Signature Def - the XPath expression that created the bundle. 

Report - provides all the information contained in the Overview tab in a printer friendly 
format. The report can be copied to your paste buffer or printed with the context menu. 
You can access the context menu by right-clicking inside the Bundle Details editor. 
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Figure 4-64  Bundle Details Report Tab

When the Outline View is open and the Bundle Details editor is active, you can use the Outline 
View to control what the Bundle Details editor displays. Clicking the Overview and Report nodes 
in the Outline View brings the corresponding tabs of the Bundle Details editor to the forefront.
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Figure 4-65  Bundle Details Outline View
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Shortcut Table
The Shortcut Table is a view in the Document Pane that allows you to manage the shortcuts 
you've created.

Figure 4-66  Shortcut Table Sorted by Shortcut Name

To open the Shortcut Table, select Show View > Shortcut Table from the BEA Guardian Window 
menu.

The Shortcut Table lists the shortcuts, each having these columns:

Figure 4-67  Shortcut Table Column Headings

Shortcut: the shortcut name 

Domain: the domain the shortcut targets 

Bundle: the signature bundle the shortcut evaluates 

By default, the shortcuts are listed alphabetically by shortcut name. Clicking a column heading 
sorts the shortcuts by that column. For example, clicking the Domain column sorts the shortcuts 
alphabetically by domain name. Clicking the same column heading in succession alternates 
between sorting in alphabetical order and reverse alphabetical order.
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Figure 4-68  Shortcut Table Sorted by Domain Name

The Shortcut Table toolbar contains buttons to add and delete shortcuts:

Figure 4-69  Shortcut Table Toolbar Buttons

Clicking the Add Shortcut button invokes the Shortcut Wizard to create a new shortcut. 

Clicking the Delete Shortcut button pops up a confirmation box to confirm that you really 
want to delete the selected shortcut. Please note that the Delete Shortcut button can't be 
clicked until a shortcut has been selected. 

Related Concepts
Shortcut 

Domain 

Bundle 

Evaluation 

Related Tasks
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Shortcut Wizard 

Shortcut Explorer 

Main Menu 
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Wizards
The wizards available in BEA Guardian are:

Domain Activation Wizard 

Domain Deactivation Wizard 

Evaluation Wizard 

Support Case Wizard 

Inventory Wizard 

Shortcut Wizard 

Shortcut Evaluation Wizard 

Update Wizard 

A Wizard is a series of one or more dialog boxes that allow you to complete certain BEA 
Guardian tasks. The wizard prompts you for the information BEA Guardian needs to complete 
the task. For example, the Evaluation Wizard prompts you for the target domain and the signature 
bundle to evaluate.
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Figure 4-70  Evaluation Wizard Dialog Box

When all the required information is filled in, you can click the Finish button to actually execute 
the task. When the Domain Activation, Domain Deactivation, Evaluation, and Inventory Wizards 
finish, the Progress View indicates successful completion. The Update and Support Case Wizards 
have their own notification, and the Shortcut Wizard gives no notification.

Figure 4-71  Progress View Successful Completion

Related Concepts
Domain 
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Bundle 

Evaluation 

Related Tasks
Activate Domain 

Deactivate Domain 

Evaluate Domain 

Submit Support Case 

Inventory Domain 
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Related Reference
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Shortcut Evaluation Wizard 
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Domain Explorer 
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Domain Activation Wizard
The Domain Activation Wizard prepares a target domain for evaluation by installing any needed 
Guardian Agents and creating a new Domain Inventory.

There are several different ways to invoke the Domain Activation Wizard:

Press Ctrl+Shift+A. 

Click the Activate button on the Main Toolbar. 

Figure 4-72  Main Toolbar with Activate Button

Select New > Domain from the File menu. 

Right-click inside the Domain Explorer and select Activate Domain from the pop-up 
context menu. 

The Domain Activation Wizard contains the following data entry fields:



Refe rence

4-78 BEA Guardian User Guide

Figure 4-73  Domain Activation Wizard

The communication protocol - either http://, or https:// for Secure Sockets Layer (SSL) 
encryption. Please note that Guardian does not use 128 bit SSL encryption for domain 
activation.

The host name - the listen address of the target domain's Administration Server, for 
example, localhost, 66.248.193.194, or guardian-dev.bea.com 

The port number - the listen port for the target domain's Administration Server 

The username of an administrator account on the target domain 

The password of an administrator account on the target domain 

Whether to remember the username and password 

If selected, the username and password are encrypted and stored on disk. Then, whenever 
you access the domain, the username and password are filled in automatically. Otherwise, 
you have to enter them. The following Guardian operations require login credentials:

– Evaluate a domain 

– Inventory a domain 
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– Modify a domain 

– Open an admin console 

– Submit a support case 

Whether to use a proxy server to access the domain 

If selected, you must select the name of the proxy server from the drop down list. If there 
are no proxy servers in the drop down list, click the Add Proxy Server link to add one. 
Please note that in order to use a proxy server, you must also manually deploy the 
Guardian Agent onto the target domain.

If a deactivated domain is selected and the Domain Explorer is active when you invoke the 
Domain Activation Wizard, the communication protocol, host name, and listen port will be filled 
in with the deactivated domain's values already. But you still have to enter the username and 
password.

Once you have entered the required data, click the Finish button to activate the domain. A 
progress indicator tracks the progress as the domain is activated.

The successful completion of the Domain Activation Wizard results in:

The domain is available for evaluation. 

Any needed Guardian Agents are installed on the domain. 

The Progress View shows the time the activation finished. 

Figure 4-74  Domain Activation Wizard Successful Completion

A new Domain Inventory editor is opened in the Document Pane. 
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Figure 4-75  Activated Domain Domain Inventory

A domain node is added to the Domain Explorer, in the Target Domains folder. A Domain 
Inventory entry is also added to the domain node's Inventory History folder. 
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Figure 4-76  Activated Domain Domain Explorer Entry

The domain is added to the Active Domain Table. 

Figure 4-77  Activated Domain Active Domain Table Entry

The domain is added to the Guardian Registry. 

A folder for the domain is added to the Guardian Workspace. The domain folder persists 
the Domain Inventories, Evaluation Summaries, and Case Creation Archives. 
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Figure 4-78  Activated Domain Domain Folder
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Manually Deploy Guardian Agent
When activating domains using proxy servers, you must Manually Deploy the Guardian Agents. 
The Guardian Agent is a light weight web application. It is included in the .plugins directory of 
your Guardian installation in WebLogic Server 8 and 9 versions. The following steps summarize 
how to manually install and deploy Guardian Agents.

Set up your browser for proxy access: 

– Mozilla: 

• Go to Tools, Options, General, Connection Settings. 

• Select Manual Proxy Configuration. 

• Enter the proxy server's host name and listen port. 

– Internet Explorer: 

• Go to Tools, Internet Options, Connections, LAN Settings. 

• Select Use a proxy server for your LAN. 

• Enter the proxy server's host name and listen port. 

Login to your domain console: 

– Use the domain's URL and listen port, for example, 
http://guardian-dev:7001/console 

– Go to Deployments, select Web Application Modules 

– If there's a bea-guardian-agent web application listed already, delete it by 
clicking the trash can icon. 

Deploy the Guardian Agent Web Application: 

– Select Deploy a New Web Application Module.... 

– Select upload your file(s). 

– Click the Browse... button. 

– Navigate to .plugins/com.bea.guardian.agent.weblogic* in your Guardian installation 
directory. Select either weblogic8 or weblogic9. Select the 
bea-guardian-agent.war file. 

– Click the Upload button. 

– Select the bea-guardian-agent.war module. 
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– Click the Target Module button. 

– Click the Deploy button. 

Once the Guardian Agent has been deployed, you can activate your proxy server domain.

Related Concepts
Domain 

Guardian Agent 

Related Reference
Domain Activation Wizard 

Related Getting Started
Installation 
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Add Proxy Servers
To use a proxy server when activating or modifying a domain, you must add the proxy server to 
the Domain Activation Wizard or Domain Properties dialog box's proxy server drop down list. 
The following steps describe how to add a proxy server:

Click the Add Proxy Servers link in the Domain Activation Wizard or Domain Properties 
dialog box to open the Preferences Proxy Servers page. 

Figure 4-79  Add Proxy Servers Link

In the Proxy Servers page, click the Add button to open the Proxy Properties dialog box. 

Figure 4-80  Preferences Proxy Servers Page with No Entries

In the Proxy Properties dialog box, enter the proxy server's host name, listen port, 
username, and password. Click the OK button to add the proxy server to the Proxy Servers 
page's proxy servers list. 



Main  Menu

BEA Guardian User Guide 4-87

Figure 4-81  Proxy Properties Dialog Box

Back in the Proxy Servers page, you can see the proxy server you just added. Click the 
Add button for as many proxy servers as you need to add. Click the OK button to return to 
the Domain Activation Wizard or Domain Properties dialog box. 

Figure 4-82  Preferences Proxy Servers with Example Entry

Back in the Domain Activation Wizard or Domain Properties dialog box, you can select 
any of the proxy servers you just added. 
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Figure 4-83  Added Proxy Server Selected
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Domain Deactivation Wizard
The Domain Deactivation Wizard makes a domain unavailable for evaluation.

There are two different ways to invoke the Domain Deactivation Wizard:

Select a domain in the Active Domain Table and click the Deactivate Domain button. 

Right-click a domain in the Domain Explorer and select Deactivate Domain. 

The Domain Deactivation Wizard dialog box prompts you for the domains to deactivate. By 
default, the domains selected when you invoked the Domain Deactivation Wizard are 
highlighted. You can deactivate multiple domains at once.

Figure 4-84  Deactivation Wizard Dialog Box

When you've selected the domains to deactivate, click the Finish button. The deactivation 
completes immediately because the operation is local to Guardian and the domains are not 
contacted.

The successful completion of the Domain Deactivation Wizard results in:

A pop-up dialog box indicates successful completion. 
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Figure 4-85  Deactivation Wizard Successful Completion Dialog Box

The Progress View shows the time the deactivation finished. 

Figure 4-86  Deactivation Wizard Successful Completion Progress View

The domains are removed from the Active Domain Table. 

The domains are still listed in the Domain Explorer so you can access their previous 
Domain Inventories and Evaluation Summaries. But they are no longer displayed with a 
bold font. 

Figure 4-87  Deactivation Wizard Successful Completion Domain Explorer
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You can remove deactivated domains from the Domain Explorer with the Purge Inactive 
Domains option from the Tools menu.

Any shortcuts that target the deactivated domains are removed from the Shortcut Table and 
Shortcut Explorer. 

The domains can no longer be selected for evaluations or inventories. However, you can 
activate the domain again at any time. 

Please note that the Domain Deactivation Wizard does not remove any of the Guardian Agents 
that were installed during domain activation. If you want to remove the Guardian Agents after 
deactivating a domain, you can use the deployment tools provided with WebLogic Server. 
Guardian Agents are deployed as Web Application Archive (WAR) files with the name, 
"bea-guardian-agent". Deployment documentation can be found on the BEA eDocs website for:

BEA WebLogic Server 8.1 

BEA WebLogic Server 9.1 

BEA WebLogic Server 9.2 

Related Concepts
Domain 

Evaluation 

Shortcut 

Guardian Agent 

Related Tasks
Deactivate Domain 

Activate Domain 

Related Reference
Active Domain Table 

Domain Explorer 

Domain Inventory 
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Evaluation Summary 
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Evaluation Wizard
The Evaluation Wizard allows you to evaluate one or more domains.

There are several different ways to invoke the Evaluation Wizard:

Press Ctrl+Shift+E. 

Click the Evaluate button on the Main Toolbar. 

Figure 4-88  Main Toolbar with Evaluate Button

Select New > Evaluation from the File menu. 

Double-click a domain in the Active Domain Table. 

Double-click a domain in the Domain Explorer. 

Right-click a domain in the Domain Explorer, or anywhere in the Domain Explorer, and 
select Evaluate from the pop-up context menu. 

The Evaluation Wizard dialog box contains the following data entry fields:

The domains to evaluate - click the domain you want to evaluate. Use the Ctrl or Shift 
keys when clicking to select more than one domain. Please note that any domain selected 
with the Domain Explorer or Active Domain Table active when the Evaluation Wizard is 
invoked will be preselected already. 
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Figure 4-89  Evaluation Wizard with Two Domains Selected

The bundle to evaluate - for each domain, you can select one bundle to evaluate. The 
Default Signatures bundle is selected by default. To change the bundle, click the bundle 
name and select a different bundle from the drop down list. 
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Figure 4-90  Evaluation Wizard with Bundle Selected

The domain login credentials - if you checked the Remember username/password check 
box when activating or modifying the domain, the username and password are already 
filled in. Otherwise, the domain is displayed in italics, and you must enter the username 
and password in the Domain Credentials section. 

If you have multiple domains selected, every one must have its credentials filled in before 
you can launch the evaluation. If any of the selected domains are missing credentials, a 
message at the top of the dialog box says that the required credentials are missing and the 
Finish button is greyed out.
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Figure 4-91  Evaluation Wizard Enter Domain Credentials

Whether to remember the username and password - if you check the Remember 
username/password check box, you won't have to enter domain login credentials for any 
future domain access operations. 
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Figure 4-92  Evaluation Wizard Remember Username and Password

Whether to create a shortcut - if you check the Create Shortcut check box, the domain and 
bundle evaluated are saved as a shortcut for future evaluations. If evaluating multiple 
domains, you must create a shortcut for each domain and bundle pair separately. 

When you check Create Shortcut, a default shortcut name is created in the text box next to 
it. The default shortcut name is in the form, "<bundle name> in <domain name>". You can 
change the shortcut name by editing the text box.
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Figure 4-93  Evaluation Wizard Create Shortcut

When you've finished editing the Evaluation Wizard dialog box, you can click the Finish button 
to launch the evaluation. A progress indicator tracks the progress as the evaluation executes.

The successful completion of the Evaluation Wizard results in:

The Progress View shows the time it finished for each domain evaluated. 

Figure 4-94  Evaluation Wizard Successful Completion

A new Evaluation Summary is opened in the Document Pane. 
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Figure 4-95  Evaluation Wizard Evaluation Summary

The Domain Explorer is modified as follows: 

If you checked the Remember username/password check box, the domain node icon is 
decorated to indicate that the login credentials have been persisted. 

Figure 4-96  Domain Explorer Decorated Domain Nodes

A new Evaluation Summary entry is added to the Evaluation History folder for each 
domain evaluated. 



Refe rence

4-100 BEA Guardian User Guide

Figure 4-97  Domain Explorer Evaluation History

A new Domain Inventory entry is added to the Inventory History folder for each domain 
evaluated. 

Figure 4-98  Domain Explorer Inventory History

If you selected the Create Shortcut check box, the shortcut is added to both the Shortcut 
Explorer and the Shortcut Table. 
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Figure 4-99  Evaluation Wizard Created Shortcuts
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Support Case Wizard
The Support Case Wizard gathers the information needed to create a BEA support case. You can 
either connect to BEA to open an actual support case now, or save the case information in a Case 
Creation Archive to open a support case later.

To invoke the Support Case Wizard, click the Get more help from BEA support link in an 
Evaluation Summary. You can create a support case in response to any signature that is detected 
in an evaluation. 

Figure 4-100  Support Case Wizard Get More Help Link

You can open an Evaluation Summary either by performing an evaluation, or by double-clicking 
the Evaluation Summary entry in the Domain Explorer.

Figure 4-101  Support Case Wizard Evaluation Summary
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The Support Case Wizard uses a sequence of dialog boxes to gather the information needed to 
open a support case and allow a BEA support engineer to begin working on it. The Support Case 
Wizard steps are:

Select Server Node - identify the server node on the domain that has the detected signature. 
If the node preselected in the dialog box is not the correct one, then you can change it with 
the pull down list. If there's only one server in your domain, then the Administration Server 
is used by default and this step is skipped. 

Figure 4-102  Support Case Wizard Select Server Node

Support Case Notes - add any additional text that you feel may help resolve the support 
case sooner in the Additional Case Notes section. The Default Case Notes section already 
contains the text from the Evaluation Summary's description and remedy sections. 



Refe rence

4-104 BEA Guardian User Guide

Figure 4-103  Submit Support Case Support Case Notes

Select Case Attachments - specify which background materials to send to BEA, for 
example, the server log or the domain configuration file. Each signature includes a list of 
attachments needed to resolve the case. Some, such as the Domain Inventory, are required 
to create a support case. They are listed in the Case Attachments section and cannot be 
unselected. Others, such as the Server Log, are optional. They are listed in the 
Recommended Attachments section and are selected by default, but can be unselected. 

If you feel additional attachments would help in resolving the support case sooner, you can 
add them to the Other Attachments section by clicking the plus sign icon and navigating to 
the attachment you want to add.

By submitting these background materials now, you save the BEA support engineer from 
having to contact you to get the same information later. This saves time in getting your 
support case resolved sooner.
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Figure 4-104  Support Case Wizard Select Case Attachments

Domain Login - enter the username and password to login to the domain and get the case 
attachments specified in the previous step. If you checked the Remember 
username/password check box when activating or modifying the domain, the username and 
password are already filled in. If you check the Remember username/password check box, 
you won't have to enter domain login credentials for any future domain access operations. 
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Figure 4-105  Support Case Wizard Domain Login

Select Case Destination - select whether to connect to BEA and create a support case now, 
or save the case information as a Case Creation Archive, and create a support case later. 
Saving the case as a Case Creation Archive may be useful for people who are not 
connected to the Internet and need to send it to BEA from a different machine. 
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Figure 4-106  Support Case Wizard Select Case Destination

If you choose to save the case as a Case Creation Archive, you must select a folder in 
which to save it. BEA recommends using the data/<domain node>/Case 
Creation Archives folder in the Guardian Workspace location you specified when 
you started Guardian.
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Figure 4-107  Support Case Wizard Browse for Folder
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Figure 4-108  Support Case Wizard Select Case Destination Archive Location

eSupport Login - enter your BEA eSupport username and password. This allows Guardian 
to login to the eSupport website to get your list of available eSupport site identifiers and 
create the support case. If you select the Remember username/password check box, you 
won't have to enter your eSupport login credentials for future support cases. 



Refe rence

4-110 BEA Guardian User Guide

Figure 4-109  Support Case Wizard eSupport Login

Select eSupport Site Id - if you have more than one eSupport site identifier, select the one 
to use for this support case. This step is skipped for most customers who have only one site 
identifier. 
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Figure 4-110  Support Case Wizard Select Site Identifier

The successful completion of the Support Case Wizard results in:

The Case Creation Complete dialog box gives you the support case number, date, and time 
of creation. The time includes the time zone of BEA's eSupport website. BEA recommends 
saving the case number to aid in future correspondence with BEA. 

Figure 4-111  Support Case Wizard Completion Dialog Box with BEA Case Number

Once the case has been created, it is treated like any other BEA support case. But, because 
the Support Case Wizard included attachments specific to the case and optional notes from 
you, BEA's support engineers can analyze it more efficiently.
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If you earlier elected to save the case as a Case Creation Archive instead of connecting to 
BEA, the Case Creation Complete dialog box displays the date, time, and location of the 
archive file.

Figure 4-112  Support Case Wizard Completion Dialog Box with Case Archive

The Progress View shows the local time that the case was created. 

Figure 4-113  Progress View Successful Completion

After the case has been created, the Evaluation Summary is updated with either the BEA 
support case number, or the name of the Case Creation Archive. The Get more help from 
BEA support link is no longer available. 
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Figure 4-114  Support Case Wizard Updated Evaluation Summary
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Inventory Wizard
The Inventory Wizard allows you to create a new Domain Inventory for one or more domains.

There are several different ways to invoke the Inventory Wizard:

Press "Ctrl+Shift+I". 

Click the Inventory button on the Main Toolbar. 

Figure 4-115  Main Toolbar with Inventory Button

Select New > Inventory from the File menu. 

Right-click a domain in the Domain Explorer, or anywhere in the Domain Explorer, and 
select Inventory. 

The Inventory Wizard contains the following data entry fields:

The domains to inventory - click each domain to inventory. Use the Ctrl or Shift keys 
when clicking to select more than one domain. Please note that any domain selected with 
the Domain Explorer or Active Domain Table active when the Inventory Wizard is invoked 
will be preselected already. 
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Figure 4-116  Inventory Wizard with Selected Domains

The domain login credentials - if you checked the Remember username/password check 
box when activating or modifying the domain, the username and password are already 
filled in. Otherwise, the domain is displayed in italics, and you must enter the username 
and password in the Domain Credentials section. 

If you have multiple domains selected, every one must have its credentials filled in before 
you can create the inventories. If any of the selected domains are missing credentials, a 
message at the top of the Inventory Wizard says that the required credentials are missing 
and the Finish button is greyed out.
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Figure 4-117  Inventory Wizard Enter Login Credentials

Whether to remember the username and password - if you check the Remember 
username/password check box, you won't have to enter domain login credentials for any 
future domain access operations. 
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Figure 4-118  Inventory Wizard Remember Username and Password

When you've finished editing the Inventory Wizard, you can click the Finish button to create the 
inventories. A progress indicator tracks the progress as the inventories are created.

The successful completion of the Inventory Wizard results in:

The Progress View shows the time it finished for each domain you selected. 

Figure 4-119  Progress View Successful Completion

A new Domain Inventory editor is opened in the Document Pane for each domain you 
selected. 



Main  Menu

BEA Guardian User Guide 4-119

Figure 4-120  Newly Created Domain Inventories

The Domain Explorer is modified as follows: 

– If you checked the Remember username/password check box, the domain node icon is 
decorated to indicate that the login credentials have been persisted. 
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Figure 4-121  Domain Explorer with Decorated Domain Nodes

– A new Domain Inventory entry is added to the Inventory History folder for each 
domain you selected. 

Figure 4-122  Domain Explorer Inventory History
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Shortcut Wizard
The Shortcut Wizard allows you to create a shortcut.

There are several different ways to invoke the Shortcut Wizard:

Press "Ctrl+Shift+S". 

Click the Add Shortcut button in the Shortcut Table toolbar. 

Figure 4-123  Shortcut Table Toolbar with Add Shortcut Button

Select New > Shortcut from the File menu. 

Right-click inside the Shortcut Explorer and select Add Shortcut. 

The Shortcut Wizard contains the following data entry fields:

The domain to evaluate - click the domain you want to evaluate. Each shortcut can only 
evaluate one domain and one bundle at a time. Please note that any domain selected with 
the Domain Explorer or Active Domain Table active when the Shortcut Wizard is invoked 
will be preselected already. 
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Figure 4-124  Shortcut Wizard Domain Selection

The bundle to evaluate - for each domain, you can select one bundle to evaluate. The 
Default Signatures bundle is selected by default. To change the bundle, click the bundle 
name and select a different bundle from the drop down list. 

Figure 4-125  Shortcut Wizard Bundle Selection
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The shortcut name - when you check the Create Shortcut check box, a default shortcut 
name is created in the text box next to it. The default shortcut name is in the form, 
"<bundle name> in <domain name>". You can change the shortcut name by editing the text 
box. 

Figure 4-126  Shortcut Wizard Name Shortcut

When you've finished selecting the bundle, domain, and shortcut name, you can click the Finish 
button to create the shortcut. The successful completion of the Shortcut Wizard results in:

The shortcut is added to the list of shortcuts in the Shortcut Explorer. 

The shortcut is added to the list of shortcuts in the Shortcut Table. 

Figure 4-127  Shortcut Wizard Results

Double clicking the shortcut name in the Shortcut Explorer or Shortcut Table invokes the 
Shortcut Evaluation Wizard with the shortcut's domain and bundle already selected.
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Figure 4-128  Shortcut Evaluation Wizard
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Shortcut Evaluation Wizard
The Shortcut Evaluation Wizard allows you to evaluate a domain with fewer steps than the 
Evaluation Wizard.

You can invoke the Shortcut Evaluation Wizard in any of the following ways:

Double-click a shortcut in the Shortcut Table. 

Double-click a shortcut in the Shortcut Explorer. 

Right-click a shortcut in the Shortcut Explorer and select Evaluate Shortcut from the 
pop-up context menu. 

The Shortcut Evaluation Wizard opens with the domain and bundle specified in the shortcut 
preselected.

Figure 4-129  Shortcut Evaluation Wizard with Domain and Bundle Selected

You can change the bundle, but only for the current evaluation. The shortcut's bundle will remain 
unchanged for future invocations of the Shortcut Evaluation Wizard.
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Figure 4-130  Shortcut Evaluation Wizard with Bundle Changed

If you checked the Remember username/password check box when activating or modifying the 
domain, the username and password are already filled in. Otherwise, the domain is displayed in 
italics, and you must enter the username and password in the Domain Credentials section.
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Figure 4-131  Shortcut Evaluation Wizard Needing Login Credentials

If you check the Remember username/password check box, you won't have to enter domain login 
credentials for any future domain access operations.
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Figure 4-132  Shortcut Evaluation Wizard with Remember Username and Password Checked

When you've finished editing the Shortcut Evaluation Wizard dialog box, you can click the Finish 
button to launch the evaluation. A progress indicator tracks the progress as the evaluation 
executes.

The successful completion of the Evaluation Wizard results in:

The Progress View shows the time it finished for each domain evaluated. 

Figure 4-133  Shortcut Evaluation Wizard Successful Completion

A new Evaluation Summary is opened in the Document Pane. 
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Figure 4-134  Shortcut Evaluation Wizard Evaluation Summary

The Domain Explorer is modified as follows: 

– If you checked the Remember username/password check box, the domain node icon is 
decorated to indicate that the login credentials have been persisted. 

Figure 4-135  Domain Explorer Decorated Domain Node

– The Evaluation Summary is added to the target domain's Evaluation History folder for 
each domain evaluated. 
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Figure 4-136  Domain Explorer Evaluation History

– A new Domain Inventory entry is added to the Inventory History folder for each 
domain evaluated. 

Figure 4-137  Domain Explorer Inventory History
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Update Wizard
The Update Wizard downloads and installs new signatures and application features from the BEA 
Guardian update web site, http://guardian.bea.com/.

There are several different ways to invoke the Update Wizard:

Press Ctrl+Shift+U. 

Click the Update button on the Main Toolbar. 

Figure 4-138  Main Toolbar with Update Button

Select Manage Guardian > Update Guardian from the Help Menu. 

The Update Wizard uses a sequence of dialog boxes to gather the information needed to 
download and install new signatures and application features. The Update Wizard steps are:

eSupport Login - enter your BEA eSupport username and password to access the Guardian 
update site. If you select the Remember username/password check box, you won't have to 
enter your eSupport login credentials for future updates. 
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Figure 4-139  Update Wizard First Username and Password Prompt

Select eSupport Site Id - if you have more than one eSupport site identifier, select the one 
to use for this update. Most customers only have one site identifier. 
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Figure 4-140  Update Wizard Site Identifier Prompt

eSupport Login - enter your BEA eSupport username and password again to access the 
Guardian update site. 
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Figure 4-141  Update Wizard Second Username and Password Prompt

No updates for the currently installed features - if there are no new signatures or 
application features available, a dialog box suggests you try again later. BEA adds new 
signatures and application features to the Guardian update site when they are ready for 
customer use. 

Figure 4-142  Update Wizard No Updates Available Message

Search Results - if there are new signatures or application features available, select which 
ones to install. All of them are selected by default, but you can expand the check box to 
select specific updates. 
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Figure 4-143  Update Wizard Search Results, Unexpanded

Guardian signature updates are grouped under the Guardian Signatures heading, Guardian 
application feature updates are grouped under the Guardian heading. Select the check 
boxes next to the signature and application feature updates you want.
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Figure 4-144  Update Wizard Search Results, Expanded

Feature License - click the radio button indicating that you accept the terms in the license 
agreement. 
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Figure 4-145  Update Wizard License Agreement

Installation Location - you can change the installation location for each signature and 
application feature update, but BEA recommends using the default location. A progress 
indicator tracks the progress as the updates are downloaded. 
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Figure 4-146  Update Wizard Installation Location Selection

Feature Verification - once the updates are downloaded, click the Install All button to 
integrate all the signature and application feature updates into Guardian in one step. 
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Figure 4-147  Update Wizard Feature Verification

Restart Guardian - once all the updates are installed, click the Yes button to restart 
Guardian. When Guardian restarts, all the new signatures and application features you 
downloaded will be available. 

Figure 4-148  Update Wizard Success, Restart Message
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Crash Recovery
Due to utilizing the Eclipse Rich Client Platform, crashes are extremely unlikely. If BEA 
Guardian does crash, the Crash Recovery procedure is to simply restart BEA Guardian. No 
additional cleanup operations are required.

Related Getting Started
Starting the Graphical User Interface 
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Exceptions
In the unlikely event of an exception, the recommended steps to resolution are:

Read the text of the error message displayed and try to determine what's wrong 

Save the exception error window text with a screen capture or cut and paste 

Retry the operation to see if it repeats 

Copy the BEA Guardian log files to another location and save them for future reference 

Contact BEA Support for assistance 

To do a screen capture of the exception message window using Windows, press Alt+Print Screen 
to copy the active window, paste it into a graphics editor such as Paint, and save it as a .JPG file 
for future reference. You can also select the error message text with your mouse, right-click to 
copy it into your copy buffer, and paste it into a text editor.

To save the log files, simply copy them to another location so that the error is among the last 
entries in the log file, making it easier to identify. Guardian has three log files: guardian.log 
and signature.log in your Guardian installation directory, and .log in your Guardian 
Workspace's .metadata directory.

Related Concepts
Guardian Workspace 

Related Reference
Log Files 

Related Getting Started
Installation 
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Log Files
The BEA Guardian Log Files contain information that is typically only needed by BEA in the 
unlikely event of an exception. One situation where you may want to view a log file is running 
command line scripts and automatically scanning the signature.log for detected signatures.

The Guardian log files are:

guardian.log - located in the guardian installation directory you specified during 
installation. Contains information about every operation the Guardian application performs. 

signature.log - located in the guardian installation directory you specified during 
installation. Contains information about each evaluation performed. 

.log - located in the .metadata subdirectory of the Guardian Workspace directory you 
specified when starting Guardian. Contains information about certain Guardian operations. 

install.log - located in the configuration/org.eclipse.update subdirectory of the Guardian 
installation directory you specified during installation. Contains information about the 
Guardian installation itself. 

Related Concepts
Signature 

Evaluation 

Guardian Workspace 

Related Reference
Exceptions 

Signature Log File 

Guardian Log File 

Related Getting Started
Running Scripts 

Installation 

Starting the Graphical User Interface 
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Signature Log File
A Signature Log File, signature.log, is located in the guardian installation directory you specified 
during installation. It contains information about each evaluation performed.

Related Concepts
Evaluation 

Related Reference
Log Files 

Guardian Log File 

Related Getting Started
Installation 
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Guardian Log File
The Guardian Log File, guardian.log, is located in the guardian installation directory you 
specified during installation. It contains information about every operation the BEA Guardian 
application performs.

Related Reference
Log Files 

Signature Log File 

Related Getting Started
Installation 
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Preferences
The Preferences page allows you to customize the BEA Guardian environment.

These are the different ways to open the Preferences page:

Press "Ctrl+Shift+P" 

Select Preferences from the Window menu. 

The Preferences page is a dialog box that allows you to select from the following main categories:

Figure 4-149  Preferences Main Window

General - settings that control the appearance of, interaction with, and startup of Guardian. 
The ones most useful for Guardian are: 

– Keys - allows you to change Guardian's Keyboard Shortcuts. 
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Figure 4-150  Preferences - General - Keys

– Startup and Shutdown - allows you to change whether Guardian prompts you for the 
Guardian Workspace location when starting. 
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Figure 4-151  Preferences - General - Startup and Shutdown

Guardian - settings that control Guardian's data interactions and appearance. The ones most 
useful for Guardian are: 

– BEA Support - allows you to specify whether to use Secure Sockets Layer (SSL) 
encryption when creating support cases, and whether to use a proxy server when 
updating Guardian. Please note that Guardian uses 128 bit open source encryption for 
SSL.
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Figure 4-152  Preferences - Guardian - BEA Support

– Proxy - allows you to add proxy servers to use when activating domains. 
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Figure 4-153  Preferences - General - Startup and Shutdown

Help - settings that control how Guardian help content is displayed. 
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Figure 4-154  Preferences - Help

Install/Update - settings that control how the Guardian application is updated. The 
Automatic Updates section allows you to tell Guardian to automatically contact the BEA 
Guardian update site to find new signatures and application updates. 
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Figure 4-155  Preferences - Install/Update - Automatic Updates

Related Concepts
Guardian Workspace 

Signature 

Related Tasks
Submit Support Case 

Update Guardian 

Activate Domain 

Related Reference
Keyboard Shortcuts 

Main Menu 

Add Proxy Servers 
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Related Getting Started
Starting the Graphical User Interface 
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Glossary
The Glossary is a list of Guardian terms you're likely to encounter with their definitions:

A 

– Activate: To prepare a domain for evaluation by installing any needed Guardian Agents 
and creating a Domain Inventory. 

– Active: Only one editor or view can be active at a time. The active editor or view has 
input focus and its title bar is highlighted. 

– Administration Server: The basic administrative unit for a WebLogic Server installation 
is called a domain. A domain is a logically related group of WebLogic Server resources 
that you manage as a unit. A domain always includes only one instance of WebLogic 
Server called the Administration Server. The Administration Server serves as a central 
point of contact for server instances and system administration tools. A domain may 
also include additional WebLogic Server instances called Managed Servers. 

B 

C 

– Context Menu: A pop-up menu that opens when you right-click inside an editor or 
view. The context, or area in which you open the menu, determines what menu options 
are available. 

D 

– Deactivate: To remove a domain from the list of domains available for evaluation. 

– Document Pane: The central region of the BEA Guardian window. Contains the Active 
Domain Table, Domain Inventory, Evaluation Summary, Signature Display, and 
Shortcut Table. 

– Domain: The basic administrative unit for a WebLogic Server installation is called a 
domain. A domain is a logically related group of WebLogic Server resources that you 
manage as a unit. A domain always includes only one instance of WebLogic Server 
called the Administration Server. The Administration Server serves as a central point of 
contact for server instances and system administration tools. A domain may also 
include additional WebLogic Server instances called Managed Servers. 

– Domain Inventory: an XML document describing the products in your domain. It 
includes descriptions of your servers, Java Virtual Machines, operating systems, and 
databases. The descriptions include product versions as well as some configuration 
settings. 
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– Drop Cursors: When you click a view or editor title bar and hold the mouse button 
down to drag it, the mouse pointer changes into a drop cursor that indicates where the 
view or editor will be placed when you release the mouse button. See Interacting with 
the Graphical User Interface for a description of the drop cursor shapes. 

E 

– Editor: A window used to edit or examine a resource. 

– Evaluate: To search for signatures in your domain. The principal function of BEA 
Guardian. 

F 

G 

H 

I 

J 

K 

L 

M 

– Managed Server: The basic administrative unit for a WebLogic Server installation is 
called a domain. A domain is a logically related group of WebLogic Server resources 
that you manage as a unit. A domain always includes only one instance of WebLogic 
Server called the Administration Server. The Administration Server serves as a central 
point of contact for server instances and system administration tools. A domain may 
also include additional WebLogic Server instances called Managed Servers. 

N 

– Navigation Pane: The left region of the BEA Guardian window. Contains the Bundle 
Explorer, Domain Explorer, Shortcut Explorer, and Signature Explorer. 

– Navigator View: A hierarchical, tree structure depiction of the resources in the 
Navigation Pane. 

– Node: An expandable point in a tree hierarchy. It can be expanded by clicking the plus 
(+) sign next to it. 

O 
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– Outline View: a window to the right of the Document Pane which allows you to 
navigate the Domain Inventory, Evaluation Summary, Signature Details, or Bundle 
Details editor that is active in the Document Pane. 

P 

– Progress View: a window to the left of the Document Pane that tracks the progress as 
operations execute. It also shows the successful completion of the operation. 

Q 

R 

S 

– Severity Level: A rating of the importance of a signature, based on the amount of 
impact it could have on your domain. The severity levels are: Critical, Warning, and 
Informational. 

– Signature: An XML document that describes potential problems in your domain. It can 
be compared to the current domain state to determine if the signature exists in your 
domain. This process is known as an evaluation. 

T 

– Tab Group: A set of views or editors grouped together on a title bar in the Navigation 
Pane or Document Pane. 

– Title Bar: The upper region of a view or editor. Contains the view or editor name, an 
identity icon, a close icon, and the toolbar. 

– Toolbar: The upper region of a view or editor, part of the title bar. Contains icons for 
minimizing and maximizing the view or editor and may contain additional icons 
specific to the view or editor. 

U 

V 

– View: A window used to examine a resource. 

W 

X 

Y 

Z 
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C H A P T E R 5

What’s New

Enhancements to BEA Guardian Version 1.0.2
Following are descriptions of the more interesting changes made to BEA Guardian for the 
Version 1.0.2 release. To get Guardian Version 1.0.2, click the Update button in the toolbar of 
your existing Guardian Version 1.0 installation.

Localization Enhancements

Support for localized signatures
The Guardian Signature Repository has been restructured to include a directory for each 
supported local language. The archives subdirectory now includes directories for English, 
Japanese, Korean, and Chinese. The English and Chinese directories are further subdivided into 
directories for each regional language preference - US for United States, CN for mainland China, 
and TW for Taiwan. As local language signatures become available, the JAR file that contains 
them will replace the US English JAR file that currently resides in each directory.

CR311521 fixed
There was a problem where specifying a locale in your guardian.ini file (-Duser.language= and 
-Duser.country=) other than en_US, ja, ko, zh_CN, or zh_TW would cause Guardian to fail to 
conduct evaluations, due to not being able to find the signature JAR file. Now, if you specify a 
locale other than en_US, ja, ko, zh_CN, or zh_TW in guardian.ini, Guardian will use the 
signature JAR file in the archives subdirectory of the Signature Repository. That signature JAR 
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file is in US English, but you can replace it with one of the other supported localized signature 
files when they become available, if you prefer.

Additional localization enhancements
Additional enhancements for better localization support include:

translating more of the text in the Guardian editors to local languages

fixing broken links in the Dynamic Help

making more room for translated labels in the Support Case and Update Wizards’ Select 
eSupport Site Id dialog box

fixing the zh_CN language Domain Activation Wizard title bar.

Other Enhancements

CR308840 Fixed
Under certain circumstances related to deselecting recommended attachments, the Support Case 
Wizard would leave the Finish button unselectable in the Select eSupport Site Id dialog box. 
Now, the Finish button is active regardless of the attachments you select or deselect.
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